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Franklin Planner™ Software
License Agreement

BY BREAKING THE SEAL ON THE 
SOFTWARE DISKETTES OR CD-ROM, 
OR INSTALLING, COPYING, OR OTH-
ERWISE USING THIS SOFTWARE 
PRODUCT, YOU AGREE TO BE 
BOUND BY THE TERMS OF THIS 
SOFTWARE LICENSE AGREEMENT. IF 
YOU DO NOT AGREE TO THE TERMS 
OF THIS LICENSE AGREEMENT, YOU 
ARE NOT AUTHORIZED TO USE THE 
SOFTWARE PRODUCT AND MUST 
PROMPTLY RETURN THE PACKAGE 
TO THE PLACE WHERE YOU OB-
TAINED IT.

Purchaser’s License

Franklin Planner Software is protected 
by copyright law and international copy-
right treaty. The enclosed computer pro-
gram (software) is licensed, not sold, to 
you. You may not decompile, reverse en-
gineer, disassemble, reduce or otherwise 
attempt to discover any source code, un-
derlying ideas, algorithms, file formats 
or programming interfaces of the soft-
ware.  Except as provided in this license, 
you may not transfer, rent, lease, lend, 
copy, modify, translate, sublicense, re-
sell for profit, time-share, or electronical-
ly transmit or receive this software, me-
dia, or documentation.

You may copy this software onto a com-
puter for personal use and you may 
make an archive copy for the sole pur-
pose of protecting your investment from 
loss. As an express condition of this li-
cense, you must reproduce on each copy 
the copyright notice as it appears on the 
original software supplied by Franklin 
Covey.

Franklin Planner Software has the capa-
bility to be used by more than one person 
on the same computer.  The intent of this 
feature is to provide added functionality 
for a small group of people (such as a 
family) to maintain separate databases 
within one copy of the software.  This 

does not allow members of the group to 
make copies of the software (except for 
archive and personal purposes as de-
scribed within this manual.)  Copying 
this software to make it available for use 
by more than one person is illegal and 
will terminate this license. 

Each person using Franklin Planner Soft-
ware must purchase a separate software 
package unless they intend to work with-
in the capabilities of the multiple user 
feature.

Transferring the Software

You may legally transfer all of your 
rights to use this software to another per-
son provided you also transfer all copies 
of the software, diskettes or CD-ROM, 
and documentation (including this li-
cense agreement). Remember, by trans-
ferring your right to another person, you 
no longer have any right to use it. The 
person to whom this software is trans-
ferred may legally use it in accordance 
with copyright law, international treaty, 
and this license agreement.

Upgrades and the original version of the 
software constitute a single product. The 
original version and upgraded software 
may not be copied for use by two differ-
ent people at the same time and may not 
be transferred separately.

You agree that neither the software nor 
any direct product thereof will be trans-
ferred or re-exported, directly or indi-
rectly, into any country prohibited by the 
U.S. Export Administration Act and its 
regulations or will be used for any pur-
pose prohibited by the Act.

Limited Warranty
Franklin Planner Software and accompa-
nying physical media is warranted to be 
free of defects in materials and work-
manship for thirty days from the pur-
chase date. If Franklin Covey Co. 
receives written notification within the 
warranty period of defects in materials 
or workmanship, Franklin Covey Co. 
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will replace the defective media or docu-
mentation.  

If the software was purchased from a re-
tail store, then return the Software and 
accompanying items to that store within 
30 days of purchase with a dated receipt 
for a full refund.  If you purchased the 
Software directly from Franklin Covey 
Co., contact Franklin Covey Co. and re-
turn it with the same information to 
Franklin Covey Co., Attn: Returns De-
partment, 2580 South Decker Lake Blvd., 
Salt Lake City, UT  84119-2331. If Frank-
lin Covey does not receive notice within 
30 days of purchase, it will be assumed 
that the program is operating in a satis-
factory manner and that you wish to 
keep the program and be bound by the 
terms and conditions of this license.

Specifically, Franklin Covey Co. makes 
no representation or warranty that the 
software or documentation are error-free 
or meet any user’s particular standards, 
requirements, or needs.

Other than the above mentioned guaran-
tee and support, this program and ac-
companying media and documentation 
are provided “as is,” without warranty of 
any kind, either expressed or implied, in-
cluding but not limited to the implied 
warranties of performance, merchant-
ability, and fitness for a particular pur-
pose. The entire risk as to the quality and 
performance of the program is assumed 
by you. Should the program prove defec-
tive after the trial period, you (and not 
Franklin Covey Co.) assume the entire 
cost of all necessary servicing, repair, or 
correction. In no event will Franklin Cov-
ey Co. be liable for any damages, includ-
ing lost profits, lost savings, or other 
incidental or consequential damages 
arising out of the use or inability to use 
this program.

Termination of This License
This license will terminate immediately, 
without notice from Franklin Covey Co., 
if you fail to comply with any of its pro-
visions. Upon termination of this license, 

you must destroy all copies of the soft-
ware. You may terminate this license by 
doing so at any time.

Franklin Covey reserves all rights not 
specifically granted to the user in this 
statement.

Copyright and Trademark
Information
© 2000 Franklin Covey Co. Printed in the 
U.S.A. All rights reserved. Reproduction, 
adaptation, or translation of this docu-
ment is prohibited without prior written 
permission of Franklin Covey. What 
Matters Most, ASCEND and Weekly 
Compass are registered trademarks, and 
Franklin Planner and Franklin Planner 
Edition are trademarks of Franklin Cov-
ey Co. Palm Computing, Graffiti and 
HotSync are registered trademarks, and 
Palm VII, Palm V, Palm III, PalmPilot, 
Palm OS, Palm, the Palm Computing 
platform logo, the Palm VII logo, the 
Palm V logo, the Palm III logo, and the 
PalmPilot logo are trademarks of Palm 
Computing Inc. or its subsidiaries. Mi-
crosoft and Windows are registered 
trademarks and Outlook and Windows 
CE are trademarks of Microsoft Corpora-
tion. America Online is a registered 
trademark of Quantum Computer Ser-
vices, Inc. CompuServe is a registered 
trademark of CompuServe, Inc. 

All other brand and product names men-
tioned in this manual are trademarks of 
their respective companies. Companies, 
names and data used in examples herein 
are fictitious unless otherwise noted.
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Introducing Franklin Planner™ Software

What is Franklin Planner™ Software?
The Franklin Planner Software is a personal information manager 
(PIM) for the Windows® 95, 98, and NT 4.0 operating systems. 
You can use the Franklin Planner Software to perform many tasks, 
including:

■ Enter and prioritize daily tasks

■ Schedule appointments and set alarms

■ Take notes on commitments, conversations, and ideas

■ Store and print addresses and phone numbers

■ Import and export address and phone records

■ Print your information on Franklin Planner® pages or 
plain paper

Who Makes Franklin Planner Software?
Franklin Planner Software was created by Franklin Covey 
Company, maker of the popular Franklin Planner. Franklin Covey 
has taken the proven time-management and life-leadership tools 
of the Franklin Planner system and combined them with the 
power of the personal computer to create a unique brand of 
personal management software. Like the Franklin Planner, 
Franklin Planner Software is an organizational tool that helps you 
gain control over your life and your time, becoming more effective 
and leaving more time for you to focus on what matters most.

New Features in Franklin Planner Software
What to look for in your package of Franklin Planner Software

■ Values, Roles, Mission, and Long-Range Goal Wizards 
help you identify and act on what matters most to you 
(Chapter 3).

■ Weekly and daily planning tools (Chapter 5).

■ The Weekly Compass helps you focus on your highest 
priorities and relationships during the week (page 34).
10 Franklin Planner Software Welcome to Franklin Planner Software
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■ The new Information Manager organizes all important 
notes, journal entries, quotes, and documents (Chapter 
9).

■ New multi-user capabilities allow different members of a 
family or workgroup to keep individual data and 
preferences within one copy of Franklin Planner Software 
(page 21).

■ Franklin Planner Software features improved printing 
capabilities to all Franklin Planner filler sizes and styles.
Chapter 1 Franklin Planner Software 11
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Franklin Planner Software and
the Palm Computing® Family
of Connected Organizers

The Franklin Planner Software provides the following features and 
capabilities for your Palm electronic organizer (such as the Palm 
VII™, Palm V™, Palm III™, and PalmPilot™):

■ HotSync® technology enables you to back up the data 
stored in your Palm organizer onto your personal 
computer and synchronize the Palm organizer data with 
the Franklin Planner Software. The HotSync operation is 
a one-step procedure that ensures your data is always safe 
and up-to-date.

■ You can synchronize records between the Prioritized 
Daily Task List, Appointment Schedule, Address and 
Phone Book, and Red Tabs in Franklin Planner Software 
with the Task List (a Franklin Covey application), Date 
Book, Address Book, and Memo Pad, respectively, on 
your Palm organizer.

For more information on how to use your Palm organizer, install 
HotSync software, and synchronize Franklin Planner data with 
your Palm organizer, refer to the manuals that came with your 
Palm organizer.
12 Franklin Planner Software Welcome to Franklin Planner Software
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Before You Begin

System Requirements
■ Microsoft Windows 95 or greater

■ IBM-compatible 486 computer or higher

■ 16 MB of RAM minimum

■ 40 MB available hard disk space minimum, 60MB 
recommended

■ VGA monitor or better

■ CD-ROM drive

■ Mouse

■ One available serial port

Required for certain features
■ 9600 or higher baud modem (28,800 baud recommended)

■ Internet SMTP/POP3 or other MAPI compliant 
messaging software (required for e-mail features)

■ Web browsing software

■ Internet access

■ Windows-compatible printer

■ Infrared communication device

Before Installing Franklin Planner Software
■ You must have the Windows 95 or higher operating 

system installed and running on your computer.

■ Close any open programs or documents.

■ During installation, do not attempt to open another 
application.

■ Make sure you have at least 4 MB of available hard disk 
space where Windows is installed.

■ Make sure you have at least 25 MB of available hard disk 
space where Franklin Planner Software will be installed.
14 Franklin Planner Software Getting Started
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How to Install Franklin Planner Software

1. Insert the Franklin Planner Installer CD. The Franklin 
Planner installation screen automatically appears. If you 
do not see the installation screen, select Run from the Start 
menu, browse to the CD-ROM drive, and select the 
Setup.exe file. Click Open. Then click OK.

If you need Franklin Planner Software  on diskettes, contact 
Franklin Planner Software technical support at (801) 975-9999.

2. From the Franklin Planner Introduction screen click 
Install. The Franklin Planner Installation screen appears.

3. Click Next. The Software License Agreement appears.
Chapter 2 Franklin Planner Software 15
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4. Read the Software License Agreement. If you accept the 
terms of the agreement, click Yes. The Select Components 
dialog box appears.

5. Select the items you wish to install.

■ Make sure Franklin Planner Program Files and 
Database Tools & Utilities are checked.

■ If you are converting from ASCEND 5.0, check 
Convert my ASCEND 5.0 data (see “Converting 
ASCEND 5.0 Data” on page 19).

■ If you plan to synchronize Franklin Planner data with 
one of the Palm family of connected organizers, check 
the Palm Interface Files box. This will install the 
HotSync manager and conduits (see “Installing the 
Palm Interface Files” on page 19).

■ If you would like the option to view preloaded data 
that demonstrates how to use the Franklin Planner, 
check the Demo User box.

If you load the Demo User data , you can access the data by 
selecting “Demo User” instead of your user name from the User 
Login screen when you launch Franklin Planner Software.

■ To install electronic documentation (in Adobe 
Acrobat format) to your hard drive, check the 
Documentation box.

6. The Franklin Planner automatically chooses the 
destination path C:/Program Files/Franklin Covey/
Planner to load the program. If you want to choose a 
16 Franklin Planner Software Getting Started
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different location, click the Browse button and navigate to 
the new location. Click Next.

7. The User Information dialog box appears. Enter a user 
name. Click Next. 

The User Name you enter  will be the name of the database file 
that Franklin Planner Software first opens. If you will be 
synchronizing with a Palm organizer, your Franklin Planner 
Software user name and your Palm user name should be the 
same, to avoid confusion.

IMPORTANT If you are installing Palm Interface Files or 
Converting ASCEND 5.0 data, there are additional steps during 
installation. See “Installing the Palm Interface Files” on page 19 
and “Converting ASCEND 5.0 Data” on page 19.

8. Click Next. The Select Program Folder dialog box appears. 
If you like, change the program folder name. Click Next.

9. Follow the on-screen instruction. (If you are installing 
from diskette, insert the remaining disks when you are 
prompted.) A graphic displays the status of the 
installation process.

10. As the installation nears the finish, you will be asked if you 
want to load the Weekly Compass on Startup.
Chapter 2 Franklin Planner Software 17
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If you click Yes, the Weekly Compass will be loaded into your 
Windows System tray during startup. For more information 
about the Weekly Compass, see “The Weekly Compass” on 
page 34. If you load the Weekly Compass at Startup and also 
use the Multiple User feature (see “Creating Multiple User 
Databases” on page 21), the User Login dialog will appear 
during Windows startup. The User Name you select will 
determine which database the Weekly Compass will access.

Registration during Installation

11. As the installation nears completion, the Franklin Covey 
Product Registration window appears to prompt you to 
register your Franklin Planner Software.

Follow the directions depending on which registration option 
you select. Choose one of the following options from the 
drop-down menu, or choose Cancel if you do not wish to 
register.

■ Internet using my Web browser

■ Send information by e-mail

■ Send information by modem

■ Print a form for faxing

■ Print a form for mailing

Follow the directions that appear on your screen. The 
directions will vary depending on which registration option 
18 Franklin Planner Software Getting Started
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you select.

12. A message is displayed when installation is complete. You 
may be instructed to restart your computer.

Installing the Palm Interface Files
If you choose to install the Palm Interface Files, you can 
synchronize your data between your Palm device and the Franklin 
Planner. To install the Palm Interface Files: 

1. Check the Palm Interface Files box in the Select 
Components screen. When you start the installation, after 
entering a User Name, the User Information dialog box 
will appear.

2. Click Next. The Select Serial Port screen will appear.

3. Select the COM port where you have attached or will 
attach the Palm device’s serial cable. The default selection 
is the COM1 port. 

If you don’t know which COM port to choose, accept the default 
selection. You can change the COM port after installation with the 
HotSync Manager utility (see your Palm manual).

4. Click Next. The Select Program Folder dialog box appears, 
and the installation continues as described above.

Converting ASCEND 5.0 Data
If you have ASCEND 5.0 installed on your computer and want to 
convert your data for use in the Franklin Planner Software, follow 
these additional steps during installation:
Chapter 2 Franklin Planner Software 19
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1. Check the Convert my ASCEND 5.0 data box in the Select 
Components screen. When the installation starts, you will 
be prompted to enter a User Name in the User 
Information dialog box.

2. Click Next. The ASCEND 5.0 Database Path Selection 
screen will appear. 

3. If you are also installing Palm files, you will first select 
Palm installation options (see “Installing the Palm 
Interface Files” above). After selecting Palm options, the 
ASCEND 5.0 Database Path Selection window will appear.

4. Using the Browse button, locate your ASCEND 5.0 
database. When you have located it, click OK, then click 
Next. 

5. As the installation continues, a Conversion dialog box will 
appear with the prompt “Before you can convert your 
ASCEND 5.0 database, you need to select the Target 
Franklin Planner User Database for the conversion.” Click 
OK.

6. The User Login dialog box appears. You need to establish 
a User name for the ASCEND 5.0 database. Choose the 
User name from the drop-down menu or create a new 
user by clicking the Add/Remove Users button. (For 
information about Multiple Users, see “Creating Multiple 
User Databases” on page 21.)

7. Click OK. The installation process will convert your 
ASCEND 5.0 database. The Select Program Folder dialog 
box appears, and the installation process will continue as 
described above.
20 Franklin Planner Software Getting Started
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Upgrading from Previous Versions
If you are a current ASCEND 97 user, there is no special 
conversion procedure for converting your ASCEND 97 data. The 
Franklin Planner installation will synchronize your databases 
automatically.

If you are a current ASCEND 5.0 user, click the Convert my 
ASCEND 5.0 data box during installation. The installation wizard 
will convert your database as described in “Converting ASCEND 
5.0 Data” above.

Creating Multiple User Databases
The Multiple User feature allows several users to create separate 
databases using one copy of Franklin Planner Software. However, 
only one database may be open at a time. This allows several 
members of one family to maintain entirely separate databases, or 
for an assistant to easily update a manager’s schedule while 
keeping a separate personal database.

All databases can be password protected. See page“Protecting your 
database with a password” on page 116.

Adding a New User with a New Database

1. Start Franklin Planner Software if it is not already 
running, by double-clicking the desktop icon or choosing 
Start, Programs, Franklin Covey, Franklin Planner, 
Franklin Planner.

2. From the Options menu, select Preferences. The 
Preferences window appears. Select the Application 
Preferences tab.

3. Click Add/Remove Users. The User Profiles dialog box 
appears. It will display a list of all User Names currently 
using this copy of the Franklin Planner.
Chapter 2 Franklin Planner Software 21
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The User Login dialog box appears  when you start the Franklin 
Planner. The User Profiles dialog box appears when you click 
Add/Remove Users to allow you to pick which database to access.

4. Click Add. The Adding a New User dialog box appears. 
Check Create a new user with a new database radio 
button. This option will create a blank database for the 
new user’s name.

Clicking Add a new user with an existing database  will allow a 
user name to link to a database that already exists but is not yet 
used in the Franklin Planner. See “Adding a New User with an 
Existing Database” on page 23 for more information.

5. Click Next. You need to establish a new .mdb file for the 
new user. Click the Browse button. The Create new 
Franklin Planner database screen will appear. Enter the 
filename of the new user. Click Save.
22 Franklin Planner Software Getting Started
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The name of the file will also be the login name  for the new 
user. The name of the file and the login name must be the same

6. Click Finish, then click OK and OK again to close the 
Preferences windows.

When you launch your Franklin Planner, the User Login 
screen will appear and prompt you to pick a user name. This 
will link you to the appropriate database.

Adding a New User with an Existing Database

1. Start Franklin Planner Software if it is not already 
running, by double-clicking the desktop icon or choosing 
Start, Programs, Franklin Covey, Franklin Planner, 
Franklin Planner.

2. From the Options menu, select Preferences. The 
Preferences window appears. Select the Application 
Preferences tab.

3. Click Add/Remove Users. The User Profiles dialog box 
appears. It will display a list of all User Names currently 
using this copy of the Franklin Planner.

4. Click Add. The Adding a New User dialog box appears. 
Click Add a new user with an existing database. This 
option will enable an existing database not currently used 
in the Franklin Planner to be accessed. Click Next.

5. Click the Browse button. Select the existing database. If 
the database is not in the Planner folder, you will need to 
navigate to the location of the database. The name of the 
Chapter 2 Franklin Planner Software 23
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selected database will appear in the File name field. Click 
Open.

6. The Login name for the new user will be the same as the 
file name. Click Finish, then OK and OK again to close the 
Preferences window.

Deleting a User Profile

1. Start Franklin Planner Software if it is not already 
running, by double-clicking the desktop icon or choosing 
Start, Programs, Franklin Covey, Franklin Planner, 
Franklin Planner.

2. From the Options menu, select Preferences. The 
Preferences window appears. Select the Application 
Preferences tab.

3. Click Add/Remove Users. The User Profiles dialog box 
appears. It will display a list of all User Names currently 
using this copy of Franklin Planner Software.

4. Select the User Name from the list and click Delete.

5. You will be asked if you want to permanently delete the 
database. Click Yes. The database and the User Name will 
be deleted.

6. Click OK and OK again to close the Preferences window.

Registering Your Franklin Planner Software
When you register your copy of the Franklin Planner Software, 
you are entitled to receive full customer service and technical 
support. In addition, you will be notified of enhancements, 
upgrades, and special pricing on future versions of the Franklin 
Planner, as well as information about other time and life 
management products from Franklin Covey.

See “Registration during Installation” on page 18 for information 
registration options during software installation. You can register 
Franklin Planner Software electronically using your Web browser, 
by e-mail, by modem, by fax, or by mail.
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To register your copy of Franklin Planner Software via mail

You have two options for registering Franklin Planner Software by 
mail.

7. Print a form for mailing during software installation (see 
“Registration during Installation” on page 18).

8. Fill out the postage-paid registration card in the Franklin 
Planner software package and mail it to Franklin Covey.

To register your copy of Franklin Planner software via fax

You also have two options for registering Franklin Planner 
Software by fax.

1. Print a form for faxing during software installation (see 
“Registration during Installation” on page 18).

2. Fill out the registration card in the Franklin Planner 
Software package and fax it to Franklin Covey Technical 
Support at (801) 975-9995.
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Getting Help

Online Help

In addition to this manual, there is Online Help available by 
choosing Contents and Index from the Help menu. This will open 
the Franklin Planner Online Help. 

For context-sensitive Help, which brings up a Help screen with 
information about the active item, press F1 or click a Help button 
and the Online Help will display the appropriate topic.

Technical Support Options

If you encounter a problem that cannot be corrected by referring 
to online Help or this User’s Guide, contact Franklin Covey 
Technical Support by telephone, e-mail, or fax.

Before requesting support, please experiment a bit to reproduce 
and isolate the problem. When you do contact support, please be 
ready to provide the following information:

■ The name and version of the operating system you are 
using.

■ The actual error message or state you are experiencing.

■ The steps you take to reproduce the problem.

Telephone Support

■ Voice: (801) 975-9999, Monday through Friday, 7 a.m. to 
6 p.m., Mountain Standard or Daylight Savings Time.

■ Fax: (801) 978-1133

E-mail

support_win@franklincovey.com

World Wide Web

http://www.franklincovey.com/customer/tech_support.html
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What matters most ... in your life? 

Do you spend your time working on the things that are most 
important to you?

Welcome to What Matters Most™, the Franklin Covey approach 
to managing your life and your time.  The methodology taught in 
the What Matters Most seminar from Franklin Covey is 
completely integrated into the Franklin Planner Software. If you 
are unfamiliar with the this methodology, we strongly urge you to 
take time to acquaint yourself with the concepts. There are two 
main avenues for you to learn about the Franklin Covey approach 
to time and life management.

1. Included with this software are several multimedia 
elements designed to enhance your understanding of the 
approach, including an 8-minute video overview and 
several shorter, more focused pieces. All these videos can 
be viewed from the Multimedia map. To open the 
Multimedia map, go to the View menu, select What 
Matters Most, then select What Matters Most 
Introduction. You can also access the shorter videos from 
each of the What Matters Most Wizards. The Multimedia 
map also tracks your progress as you proceed through the 
What Matters Most process.

2. Also included is a guide called Discovering What Matters 
Most, giving a more in-depth explanation of the Franklin 
Covey approach.

Additionally, there are references and explanations throughout the 
online Help files. The information that follows is meant to give 
you a “jump start” into the What Matters Most approach, and 
explain how the different Franklin Planner Software modules will 
help you discover What Matters Most.

View a
multimedia
ideo from the

What Matters
ost Wizards
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The Franklin Covey Approach
to Time and Life Management

There are lots of personal information managers on the market 
today – so what is it that makes the Franklin Planner so powerful?

The Franklin Planner is so powerful because we are not selling just 
another time management system. We are showing you how to 
most effectively manage not just your time, but your life.

When you consider how you are managing your life and your 
time, ask yourself honestly – are you proactively leading your life 
forward, or do you feel like you’re at the mercy of external forces? 
Or, in other words, are you spending time on those things of the 
greatest value to you, or is your life being driven by the less 
important?

To gain control of your life and time, may we suggest that you need 
a way to discover where you are, a way to determine where you 
want to go, and a way to tell whether you are making progress to 
your destination.

This is done by an elegantly simple three-
step process. First, you Discover... you 
identify those things that matter most to 
you. Then, you incorporate that 
knowledge as you Plan your weekly and 
daily activities. Then, you Act in the 
moment of choice according to what 
matters most.
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The Discover Phase
The Discover phase of this process is rather like 
building a compass to tell you which direction you 
want to take your life. First, you identify your 
governing Values, the highest priorities in your life 
that define your character. With these fundamental 
values in mind, you then identify who is most 
important to you, or in other words, your key Roles 
and relationships. Finally, you consider your unique 
purpose in life, as you see it, and formulate your 
Personal Mission. In this way, you Discover what 
matters most to you, a compass that you can use to 
effectively Plan and Act in order to gain control over 
your life and your time.

The Plan Phase
By some simple and effective planning, you begin to bring your 
daily activities in line with what matters most. This is done by 
creating a “map” containing long-range goals. These goals are 
based on what you learned in the Discover phase... in short, 
matters most to you. Then, you subdivide your goals into easy-to-
manage intermediate steps that can be translated into tasks and 
appointments.

With long range goals and intermediate steps 
identified, you then make weekly plans. By planning 
weekly, and scheduling what matters most first, you 
create a workable plan that is always linked to what 
matters most to you.

As you plan your week, it is also important to take 
time to re-create your most important asset–
yourself. If you don’t take time to re-energize and 
recharge yourself, you won’t be able to do anything 

else that matters most to you. Stands to reason, doesn’t it?

The Franklin Planner software includes a Long Range Goal Wizard 
and a Weekly Planning Tool to help you establish your long-range 
goals and make them happen.

Governing
Value Wizard

Role Wizard

Mission Wizard

Long-Range
Goal Wizard

Weekly
Planning Tool
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The Act Phase
If the Discover phase is your compass, and the Plan phase your 
map, then it follows that the Act phase is where you take your 
compass and map in hand and do it.

The Franklin Planner is specifically designed to help you in the Act 
phase. The first step in the Act phase is to plan your day (yes, this 
is Act, not Plan). The Franklin Planner software helps you list your 
daily tasks, prioritize them, and track them as you either complete 
them, forward them to another date, or discard them.

A key feature of organizing your day is to be realistic. Don’t give 
yourself too much to do. It’s not necessary to schedule something 
for every minute of every day... unless you thrive on that kind of 
thing. The real purpose of daily planning is simply to set the stage 
so that you can insure that what matters most is taken care of first.

The Franklin Planner software provides you with a 
Daily Planning Tool expressly designed to help you 
organize your day. Not only does it help with the 
current day, the Daily Planning Tool also allows you 
to review the previous day, forward incomplete tasks 
to the future, and give you a picture of how you are doing with 
making your plan happen.

Discover, Plan, and Act
The Franklin Covey approach to time and life management is 
deceptively simple. Through the process of Discover, Plan, and 
Act, you do more than simply gain insight into what’s most 
important to you ... you also ensure that what matters most to you 
gets into your schedule, first ... and you are thus better able to Act 
on a daily basis according to your what matters most to you.

The underlying power of this method is that your daily task list is 
no longer a random jumble of items. It reflects your highest 
priorities and goals.

Do you need another reason to use the Franklin Covey approach? 
We’ll make you a promise:

“As you align your daily activities with what matters most, you will 
significantly increase your productivity and sense of inner peace.”

Daily Planning
Tool
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What Matters Most Tools

What Matters Most Toolbar

What Matters Most Wizards

The What Matters Most Wizards are designed to take you step-by-
step through the processes of discovering your Governing Values, 
your Roles, and your Mission Statement. The Long-Range Goal 
wizard will assist you in developing goals that are aligned with the 
things that matter most to you. The Weekly and Daily Planning 
tools help you plan your week according to what matters most. 
Finally, the Weekly Compass is a quick reminder of the roles you 
are working on this week.

The Weekly and Daily Planning Tools are described in Chapter 5. 
See “The Weekly Planning Tool” on page 59 and “The Daily 
Planning Tool” on page 63.

Govering Value Wizard

Role Wizard

Mission Statement Wizard

Long-Range Goal Wizard

Weekly Planning Tool

Daily Planning Tool

Weekly Compass (located in the Windows system tray)
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Governing Values Wizard

Roles Wizard

Mission Statement Wizard

In the Governing Values Wizard, 
you can ...

■ Start building your list of 
values by using samples 
provided.

■ Add clarifying statements 
to further define your val-
ues.

■ Rank your values to make 
easier the inevitable con-
flicts between values.

In the Roles Wizard, you can ...
■ Start building your list of 

roles by using samples 
provided.

■ Add key people who de-
fine each role.

■ Add a tribute statement 
from each key person to 
give you an ideal for each 
role.

In the Mission Statement Wizard, 
you can ...

■ Build your own mission 
statement or add addi-
tional mission state-
ments (such as a 
corporate mission state-
ment).

■ Answer questions de-
signed to facilitate your 
thinking about your 
unique purpose.
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Long Range Goal Wizard

The Weekly Compass

For more information ...
If at any point you are stuck using the What Matters Most 
Wizards, the online help documentation is always available. 
Simply hit the F1 key or click the Help button.

In the Long Range Goal Wizard, 
you can ...

■ Brainstorm the steps in-
volved in pursuing a long-
range goal.

■ Immediately schedule 
events that will further 
your goals.

■ Link your goals to the 
things that matter most to 
you (your Values, Roles, 
and Mission).

With the Weekly Compass, you 
can ...

■ Quickly scan your weekly 
roles to see the events 
you have scheduled that 
support each role.

■ Remind yourself of impor-
tant activities related to 
your roles that may not be 
easily scheduled.

You construct the Weekly Com-
pass with the Weekly Planning 
Tool. See page 59 for more infor-
mation.
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Navigating the Desktop

IN THIS CHAPTER

Basic Navigation . . . . . . . . . . . . . . 36

Setting Preferences . . . . . . . . . . . . 38

Categories, Searches, and Navigating 
Between Dates  . . . . . . . . . . . . . . . 40

Creating and Editing Categories . . 40
Chapter 4 Franklin Planner Software 35



FPS Windows 7.2 Manual.book  Page 36  Tuesday, February 29, 2000  2:05 PM
Basic Navigation

The Main Toolbar

The What Matters Most Toolbar

Prioritized Daily Task List (Chapter 5)

Appointment Schedule (Chapter 6)

Daily Record of Events (Chapter 8)

Address and Phone Book (Chapter 7)

Master Task List (Chapter 5)

Information Manager (Chapter 9)

Global Search (Chapter 4)

Govering Value Wizard

Role Wizard

Mission Statement Wizard

Long-Range Goal Wizard

Weekly Planning Tool

Daily Planning Tool

Refer to Chapter 3 for a description of these wizards and tools.
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The Date Navigation Bar
You can navigate to a date in the past or the future simply by 
clicking on the Date Navigation bar. This bar is found in the 
Prioritized Daily Task List, the Appointment Schedule, and the 
Daily Record of Events.

The Date Navigation bar has three components: The Page Date, 
the Date Controls, and the Go To Date Calendar.

Page Date

The Page Date displays the active date of the modules (+ or - the 
number of days from the current date). Double click on the Page 
Date area to instantly reset the modules to the current date.

Date Controls

Go To Date Calendar

To navigate to a specific date in the future you can use the Go To 
Date calendar. Click the Go To Date Calendar button and type in 
or click on the date you want to go to on the calendar. Click OK. 
The module window will change to that date.

One Month forwardOne Month back

One Week forwardOne Week back

One Day forwardOne Day back
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Setting Preferences

Customizing your Franklin Planner will help you get the most out 
of the software. Within the Preferences dialog box, you can 
customize items such as colors, phone number styles, and views. 

1. From the Options menu, select Preferences. The 
Preferences dialog box appears.

2. Select the appropriate module tab (Application 
Preferences, Prioritized Daily Task List, Appointment 
Schedule, Address and Phone, or Information Manager.) 

3. Make any changes and click OK.

Following are some of the preferences you can change for each 
module. The Preference controls are much more detailed than is 
explained in this text. Go to the Online Help documentation for 
more specific information (press F1 at any time).

In Application Preferences, you can ...
■ Add additional users to the Franklin 

Planner
■ Synchronize dates between modules
■ Have a quote displayed every time you 

start the Franklin Planner

In Prioritized Daily Task List Preferences, you 
can ...

■ Change the types of tasks that are dis-
played

■ Change the color of normal, repeat, and 
redo tasks

■ Establish task forwarding guidelines
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In Appointment Schedule Preferences, 
you can ...

■ Set the specific hours of your work day
■ Change the color of weekends, off 

hours, and work hours
■ Change the range of hours that are dis-

played

In the Address and Phone Preferences,
you can ...

■ Establish settings for the Speed Dial 
feature

■ Change the automatic phone number 
formatting

In the Information Manager Preferences, you 
can ...

■ Decide which snap-ins to have in the In-
formation Manager, allowing you to cus-
tomize Information Manager to your 
specific needs
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Categories, Searches, and
Navigating Between Dates

Creating and Editing Categories
Categories allow you to fine-tune your information for quick 
reference and the ability to assign a color to each category allows 
you to visually track tasks and appointments.

Use the Categories dialog box to create categories that are 
accessible from any module in your Franklin Planner software. 

1. From the Edit menu, select Categories. The Categories 
dialog box appears.

2. To create a new category, click Add (regardless of which 
radio button you have checked.) The Enter Category 

Check the Show by module radio button. In 
this view, select a module from the Modules 
field and the Categories field will display the 
categories that are active in that module. For 
instance, select the Address and Phone 
module. The Categories field displays 
checks in front of “Business,” “Friend,” and 
“Personal,” indicating that these three cate-
gories are available in the Address and 
Phone module.

Check the Show by category radio button. In 
this view, select a category from the Categories 
field and the Modules field will display all the 
modules in which the category is active. For in-
stance, select Business from the Categories 
field. The Modules field displays checks in front 
of the Address and Phone, Appointment 
Schedule, and Notes modules, indicating that 
the category “Business” is available in those 
three modules.
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Name window appears. Enter the category name. Click 
OK. Your new category appears in the category list.

3. To activate a category (in the Show by category view), 
select the category and check the boxes in front of the 
modules in which you want to make the category active. 
To make the category available in all modules, click Check 
All.

4. To activate a category (in the Show by module view), 
select the category and check the box in front of it. This 
will make the category active only in the module selected 
in the left field. To make the category active another 
module, select a different module and check the box in 
front of the category. Clicking Check All will make all 
categories active for the selected module. 

5. To add a color to your category, select the category, then 
click Color. From the color palette, select one of the basic 
colors or define a new custom color. For more 
information about choosing and defining colors, see the 
documentation that came with your operating system. 
After you have picked a color, click OK.

Conducting a Global Search
Global Search is a powerful tool that allows you to search for a 
word or a line of text within your data files. Global Search can 
search for data in the Address and Phone book, the Appointment 
Schedule, the Daily Record of Events, the Master Task List, the 
Prioritized Daily Task List, and your Special Days list.

1. Click the Global Search button located on the Main 
Toolbar. The Global Search window appears.
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2. Establish your search criteria and click Search.

3. Double-click the information you wish to view. You will 
be taken directly to the module where the information is 
stored. 

Using the Floating Calendar
The Floating Calendar is a one-month calendar containing date 
navigation controls and quick access to several frequently used 
features in the Franklin Planner. To open the Calendar select 
Calendar from the View menu.

Enter the word or group of words 
you wish to locate. Click Exact 
Match to search for the word(s) 
exactly as it appears in the field. 
When searching for multiple 
words, click AND to search only for 
instances when all the words oc-
cur. Click OR to search for instanc-
es when at least one word occurs.

Enter the dates to begin and end 
your search.

The search results will be displayed 
here. Double-click on the entry you 
would like to view in the Module and 
Description field. You will be taken di-
rectly to the area where the information 
is stored. The Additional Information 
field displays task status, task priority, 
description, category, date entered, ad-
dress and phone number, etc.

Select the modules to search. 
Click Select All to search all 
the Franklin Planner modules.

Click here to clear cur-
rent search criteria.
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The Print button opens the print dialog box for the module that is 
currently active. 

The Speed Dial button can be used if you have a modem. If you 
have a modem connected, you can click this button to bring up the 
Speed Dial dialog box. See “Using the Franklin Planner Dialing 
Function” in the Online Help for more information. 

The Global Search button opens the Global Search dialog box. See 
page 41.

The Goto button opens the Goto Calendar and allows you to 
navigate to a specific month and year.

The Special Days button opens the Special Days dialog box 
allowing you to designate recurring events such as holidays and 
birthdays or one-time events such as vacations and business trips. 
See page 73.

The Timers button opens the Timers dialog box and allows you to 
track the length of a phone call or task. See “Using Timers” in the 
Online Help for more information.

For more information ...
The Online Help documentation gives detailed information about 
setting your preferences and categories. To access the Online Help, 
select Contents and Index from the Help menu or press F1 at any 
time. 
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The Prioritized Daily Task List

By incorporating the Franklin Covey time management principles, 
the Prioritized Daily Task List helps you focus your energy on what 
matters most. The Task List works hand-in-hand with the Weekly 
and Daily Planning tools, reminding you of the values-based tasks 
you need to accomplish each day to achieve the goals you have set 
for yourself.

With the Prioritized Daily Task List, you can:
■ Prioritize your daily list of tasks according to what matters 

most to you

■ Forward (or reschedule) tasks to a future date

■ Create redo and repeat tasks for tasks you do often

■ Link a task to a contact in the Address and Phone book

■ Filter your task list to display only certain tasks

Prioritizing is the process of organizing your tasks based on what 
is most important to you. Assign A, B or C priorities to each of 
your tasks, based on their importance.

A – Vital (Tasks that must be completed today)

B – Important (Tasks that should be completed today)

C – Optional (Tasks that could be completed today)

Once you have assigned a priority to each of your tasks, the next 
step is to rank your tasks. Ranking helps you organize your 
prioritized tasks by assigning a number to each task (A1, A2, B1, 
etc). 

Prioritizing tasks helps you effectively
handle interruptions

For example, suppose you are working on an A1 task when you are 
interrupted by a coworker who wants to discuss a project that you 
consider a B priority. Don’t confuse urgency with importance – 
you’re A1 task is still most important to you, so schedule some 
time with your coworker later in the day to work on that B project, 
then get back to work on your A1 task.
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The Prioritized Daily Task List main view

Prioritized Daily Task List Action Codes
As your day progresses, keep track of the status of your tasks with 
Action Codes. You can select from the following codes to indicate 
the status of a task.

Displays the action code you as-
signed the task to indicate its status.

Displays the priority and rank that 
you assigned to the task.

Displays the task description. You 
can edit the description from this 
view.

Displays any task notes that you 
have added to the task. You can 
edit the notes from this view.

Not Complete

Task Complete

Planned Forward

Task Deleted

Delegated Task

Planned Forward Completed

In Process

Delegated and Completed

In Process and Completed
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The Prioritized Daily Task List toolbar

Creating a New Task
1. Open the Prioritized Daily Task List. 

2. Click on the New Task button

or

Select Add Task from the Edit menu.

Clicking on a blank task line is the quickest way to add a task. You 
can also add a note to the task simply by entering the text in the 
Notes section while the task is selected.

3. If you click New Task or select Add Task, the Task 
Properties dialog box will appear.

Add a new task

Edit a task

Delete a task

Assign a filter to your task list

Create/edit repeat tasks

Assign action codes

Get incomplete tasks

Quick prioritize

Time/date stamp

Link a contact to a task

Attach a file to a task

Spell check

Move a task
to a group of tasks

Prioritize your entire task list
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4. Enter your task information in the Properties tab of the 
Task Properties dialog box.

5. Click the Notes tab and enter notes that will provide 
further description. Any editing done in this tab will be 
saved and appear in the notes field of the task.

6. Click the Repeat tab. You can enable the repeat feature to 
easily make any task a repeat task. Descriptions of the 
features are below.

Enter a description of the task. This can 
be edited as needed. A task description 
can have a maximum of 255 characters.

Select the date on which you 
want the task to appear on your 
Prioritized Daily Task List.

Enter the priority code and the 
rank of the task (A1, A2, B1, B2, 
etc.) This can be changed as 
needed.

Choose a category for your task. 
The drop down menu lists your 
categories along with the colors 
you have assigned to each field.

Select the Action Code from 
the drop-down menu that best 
describes the status of the task.

Enter the name of the person to whom 
you delegated a task. In order to use this 
feature, you must have the Delegated 
action code or the Delegated and Com-
pleted action code selected in the Task 
Code field.

Link contacts from 
your Address and 
Phone list to a spe-
cific task.

Attach files, objects, 
or images to a specific 
task.
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How to set up some common repeat tasks:

■ Pay rent on the 3rd of every month.

Enter a “3” in the Day field and a “0” in the Month field. The 
task will appear on the 3rd of each month.

■ Read 10 pages of a book each day.

If they’re not already checked, check each of the days in the 
Weekdays field and each of the boxes in the Weeks field. The 
task will appear on your task list every day.

■ Update a report once every two weeks.

Enter a “2” in the Every field and click the Weeks button. Set 
the Starting Date to the day of the week you want the task to 
begin to appear (if not the current day).

Check this box to enable the re-
peat task dialog box. If you no 
longer want the task to repeat, 
uncheck the box and the guide-
lines you have established will 
no longer apply to the task.

Enter a specific date or day of 
the month for a task to repeat. 
Enter a “0” in the Month field to 
repeat a task on the same day 
every month.

This control reads like a sentence. 
“This task will repeat once every 
______.” For instance, enter a “2” 
in the Every field, and click the 
Weeks button, and the task will 
repeat once every two weeks be-
ginning on the date entered in the 
Starting Date field.

This control allows you to 
specify which days of the 
week on which the task will 
appear. By default, every 
day is checked. 

This control is used with the 
Weekdays field to further de-
fine the repeat task. After 
you have selected a Week-
day(s), you can then decide 
which weeks of the month 
you want to view the task
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7. Click the Statistics tab to view your task statistics. From 
this tab you will view tracking information about your 
task.

8. After completing all the pertinent information concerning 
your task, click OK. The task will appear on your 
Prioritized Daily Task List.

Editing a Task
1. Open the Prioritized Daily Task List.

2. Select the task you wish to edit and click the Edit Task 
icon.

3. Make changes as needed (click either the Properties, 
Notes, Repeat, or Statistics tab). See above for more 
information.

4. Click OK to exit the Task Properties dialog box. 

Creating a Repeat Task
Another way to create a repeat task is to use the Repeat Task dialog 
box. The controls remain the same as shown above, but you are 

If you have forwarded a daily 
task to another date, the new 
date will be displayed.

This will track how many times 
a particular task has been for-
warded.

If you designated a specific per-
son in the Properties tab to 
whom you delegated this task, 
the name will appear in this 
field.

This area is useful for keeping a close account of your time.  Before you start a task, enter the 
amount of time you think it will take you to complete the task in the Estimated Time field. After 
completing the task enter the actual amount time it took to complete the task in the Actual Time 
field. To accurately track your time, use the Timers. Select Timers from the File menu to open 
the Timers dialog box.
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not able to track the task statistics or disable the repeat feature (you 
must simply delete the task if you no longer want it to repeat.) 

1. Click the Repeat Task button in the Prioritized Daily Task 
List Toolbar or select Repeat Tasks from the Options 
menu. The Repeat Task dialog box appears.

2. Click Add. The Task Properties dialog box appears.

3. Set up the guidelines for your repeat task (click either the 
Properties , Notes , or Repeat tab). 

The controls in the Repeat Task properties box work the same 
as the controls in the normal task properties dialog box. However, 
since you are already creating a repeat task, the ability to enable 
or disable the repeat feature is not available.

4. Click OK to exit the Task Properties dialog box. Then click 
Close to exit the Repeat Task dialog box.

Creating a Redo Task
A Redo task is rescheduled each time you complete it. For 
example, you could enter the task “Get a haircut” and set it to recur 
every 30 days. When you mark the task complete, it will be 
rescheduled 30 days from the date you mark it complete.

1. Select a task in the Prioritized Daily Task List.

2. Select Redo Tasks from the Options menu. The Redo Task 
dialog box appears.

3. The task that you selected in the Prioritized Daily Task List 
appears in the Task field. 

4. In the Days to Redo field, enter the number of days after 
completion that you want the task to reappear.

5. Click OK. 

Moving a Task to a New Date
1. Select the task you want to move and choose Move Task 

from the Edit menu or right-click the task and select Move 
Task from the drop-down menu. The Move Task window 
appears.

You can also move daily tasks from the Prioritized Daily Task 
List to the Master Task List by dragging and dropping the tasks.
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2. Click OK. The task will be removed from the original date 
and appear on the new date.

Another way to move a task is to select the task and click the 
Edit Task button. Change the dates in the date field of the Task 
Properties box and click OK. The task will appear on the new date.

Defining Categories for the Prioritized Daily Task List
One of the new features in the Franklin Planner Software is the 
ability to set global categories and share them with any or all of 
your Franklin Planner Software modules. Within the Categories 
window you can also set colors for each category. The global 
categories will allow you to easier and more efficient use of 
categories.

Printing Your Prioritized Daily Task List
1. Open the Prioritized Daily Task List.

2. Select Print Tasks, Appointments, and Notes from the File 
menu. The Print Tasks, Appointments, and Notes 
window appears.

3. The top half of the print dialog is fairly consistent for all 
the Franklin Planner modules.

Select the date to which you 
want to move the task.

The Tasks on Date and Appointments 
on Date windows display your tasks 
and appointments already scheduled 
for the new date.

By checking the Move to Master Task List box, you can move the task to the Master Task List 
rather than forwarding the task to another day. You can also use the Master Task List Category 
pull-down menu to select a category for the task.
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4. Click the Options button to view more printing options.

5. After you set all of the controls, click Print. 

Use this control to set the margins 
of your printing area. Unless you 
are familiar with this feature, leave 
the values at 0.000. If the printout 
is not aligned, print a test page, 
then adjust the values as needed 
and print another test page until 
the page aligns properly.

Select your binder page 
size from the drop-down 
menu. You can also 
print to plain 8.5 x 11 pa-
per.

View the page(s) you are go-
ing to print so you can verify 
that what you want to print is 
what will actually print.

Choose which pages of the daily 
view to print. This emulates the lay-
out of regular planner pages, so 
the left pages include your task list 
and appointments. The right pages 
include your Daily Record of 
Events and Task/Appointment 
notes.

Select the starting and ending 
dates of the information you want 
to print. Select the same date for 
each field to print just one day.

Make adjustments to the printer 
setup, such as the printer selection, 
paper size, or paper source. Make 
any adjustments, then click OK.

The Edit Appointment button allows you to customize how 
your appointments are printed. However, it will not affect 
how your tasks are printed. For information on this feature, 
see “Printing Your Prioritized Daily Task List” on page 53.

Select the filler style (Seasons, 
Original, etc.) to which you want to 
print. This will vary by the binder 
size chosen above.

This control allows you to check 
which items to include in the print-
ing. Check a box to include the 
item, or uncheck it to exclude it from 
this printing. 

This displays your destination 
printer. If this is incorrect, click 
Setup and change you printer 
settings.

Use the Filter drop-down menu to 
choose and apply one of your Prior-
itized Daily Task List Filters before 
you print to limit your data.

To print in color 
(i.e. category col-
ors) check the Print 
in Color box.
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For more information ...
The online help system included with your Franklin Planner 
Software provides documentation on all of the other features of 
the Prioritized Daily Task List, including:

■  Attaching files and graphics to tasks

■  Linking contact information to tasks

■  Setting Prioritized Daily Task List preferences

■  Using the Quick Prioritize feature

■  Establishing and using filters

■  HTML Auto-Publish

and more. . .

To access the online help, select Contents and Index from the Help 
menu, or press F1 at any point. 
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The Master Task List

Tasks that are not immediately urgent but may become a priority 
in the future should be entered on the Master Task List. For 
example, perhaps you want to organize a family gathering for your 
parents’ 50th anniversary next year. While this task is not a priority 
right now, it will probably become a priority in a few months. You 
can enter the task “Organize Family Party” on your Master Task 
List and then move the task to your Prioritized Daily Task List 
when it becomes a priority.

Creating a New Master Task
1. Open the Master Task List module.

2. Click the New Task button

or

Select Add Task from the Edit menu.

The Task Properties dialog box will appear.

3. There are two tabs in the Task Properties box (Properties 
& Notes). Enter your Master Task information. See below 
for a description of each field.

Enter a description of the 
master task. This can be edit-
ed as needed. A task descrip-
tion can have a maximum of 
256 characters.

Enter a priority (A, B or C) for 
the task. Master Tasks are 
not ranked. This can be 
changed as needed.

Choose a category for the 
task. The drop-down menu 
lists your categories along 
with the colors you have as-
signed to each field.

Link contacts from your 
Address and Phone list to 
a specific task.

Attach files, objects, or images 
to a specific task.

Keeps track of the number 
of days the item has been 
on your Master Task List.
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4. Click the Notes tab and enter any notes that further 
describe this Master Task.

5. Click OK.

Moving a Master Task to the Prioritized Daily Task List
Since the purpose of the Master Task List is to be a waiting area for 
tasks that are not immediately important, you will want to check 
the Master Task List on a regular basis to make sure you do not 
forget any tasks. This is one of the steps of Weekly Planning Tool, 
which is explained on page 59. When a task becomes a priority, 
you can move it to the Prioritized Daily Task List so that it 
becomes part of your daily planning.

1. Open the Master Task List.

2. Select the Master Task that you want to move to the 
Prioritized Daily Task List. 

3. Click the Move Task button. The Move To dialog box 
appears.

4. Click OK. The task will appear on that day’s Prioritized 
Daily Task List.

You can also move tasks back and forth  from the Master Task 
List and the Prioritized Daily Task List by dragging and dropping 
tasks from one list to the other.

Using the date controls, pick 
the date on which you want 
the task to appear on your 
Prioritized Daily Task List.

These two fields display 
previously scheduled tasks 
and appointments for the 
date selected.
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Printing Your Master Task List
1. Open the Master Task List.

2. Select Print Master Task List from the File menu. The 
Print Master Task List dialog box appears. 

3. Make any changes to the setup as detailed below.

4. Click Print.

Use this control to set the 
margins of your printing ar-
ea. Unless you are familiar 
with setting margins in 
Franklin Planner, leave the 
values at their preset val-
ue. If the printout is not 
aligned properly, print a 
test page, then adjust the 
values as needed and print 
another test page until the 
page aligns the way you 

Select your binder page size 
from the drop-down menu. You 
can also print to plain 8 1/2 x 11 

If you want, you can view the 
page(s) you are going to print 
before you print them.

Make adjustments to the printer 
setup if needed, such as the 
printer selection, paper size,or 
paper source. Make any adjust-
ments, then click OK.

Select the category of Mas-
ter Tasks that you want to 
print. The default is <All> 
tasks.

You can choose to print all 
pages of your Master Tasks, 
or just even pages, or just 
odd pages.

With Customize, you can 
choose width, height, and 
header and footer options for 
the printed area of your Mas-
ter Task printout.
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The Weekly Planning Tool

The Weekly Planning Tool is new to the Franklin Planner 
Software. It is an important part of the Franklin Covey time 
management process. How to discover what matters most and the 
significance of weekly planning are outlined in a supplemental 
booklet included with this software as well as in the online Help. 

Using the Weekly Planning Tool
1. Open the Weekly Planning Tool. The icon is found on the 

What Matters Most toolbar. The Weekly Planning 
introduction screen appears.

There are five steps in the Weekly Planning process: Review 
What Matters Most, Evaluate Last Week, Review Master Task 
List, Select Weekly Compass Roles, and Schedule Weekly 
Compass Events. The Weekly Planning Tool will take you 
through each step.

2. Click the Next button until you reach the Review What 
Matters Most screen. Focusing on the things you consider 
most important is vital in planning your week.

3. The next screen is the Evaluate Last Week screen. Use this 
screen to see how well you accomplished the most 
important items and remind yourself of any loose ends.

Click each one of the radio 
buttons to view your What 
Matters Most information in 
the field on the right. You 
cannot make changes to 
your information from here, 
as this screen is for review 
purposes only.
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4. The next screen is the Review Master Task List screen. 
Since the Master Task List is a “waiting area” for tasks, a 
regular check of your Master Tasks will keep you on track 
when those tasks do become important.

From the drop-down menu, 
select to view All Tasks, 
Complete Tasks, Deleted 
Tasks, or Forwarded 
Tasks. These task types 
are based on the action 
codes you assigned to the 
tasks during the week. The 
Appointments field will dis-
play all appointments from 
the week you selected.

Choose the week that you 
want to evaluate.

As you review your tasks and appointments, you may find that a task or appointment requires 
additional attention. Double-click on the task or appointment and the Task Properties or Ap-
pointment Properties dialog box will appear. Make changes as needed.

Use the Show schedule for 
date field to display your 
scheduled tasks and ap-
pointments for a specific 
day. This allows you to 
quickly view a specific day 
before scheduling a Master 
Task. Toggle between your 
scheduled tasks and ap-
pointments by clicking the 
Show Tasks or Show Ap-
pointments buttons.

Select a category from the 
Category drop-down menu 
or view all your Master 
Tasks.

To schedule a Master Task List item on your Pri-
oritized Daily Task List or Appointment Schedule, 
select the tasks, click Move To... and select Task 
or Appointment from the drop-down menu that 
appears.

Displays your 
current Master 
Task List.
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5. The next screen is the Select Weekly Compass Roles 
screen. Roles not only define who you are but also how 
you spend your time. Decide which of your roles you want 
to focus on this week.

6. The final screen is the Schedule Weekly Compass Events 
screen. Each one of the roles you just selected should have 
an event associated with it. 

To add a role to your Week-
ly Compass, select the role 
from the My Roles list and 
click Add Role. To remove 
a role from the Wekely 
compass, select the role in 
the right-hand window and 
click Remove Role.

The My Roles list displays 
roles you created in the 
Roles Wizard or the What 
Matters Most section of the 
Information Manager. If 
you created a Weekly 
Compass the previous 
week, only the roles you 
did not select will be dis-
played.

The right-hand field displays the four aspects of Sharpen the Saw as 
well as other selected roles. Review your roles in the left-hand window 
and select the ones you will add to your Weekly Compass.
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7. You can click the Back button to return to any of the 
previous screens. Any changes you make will be reflected 
in the following screens.

8. When you are finished creating your Weekly Compass, 
click Finish.

You can view the roles-related goals  you created throughout 
the week in the What Matters Most portion of the Information 
Manager, or by clicking on the Weekly Compass icon in the 
Windows system tray.

To add an event to a role, select 
the role, click Add, and select ei-
ther Appointment, Task or Other 
from the drop-down menu. If you 
choose Appointment or Task, the 
corresponding Properties dialog 
box will appear. Choose Other if 
you want to add an unscheduled 
event to a role. This might be 
something like “Spend more time 
with Tim.” It is something not tied 
to a specific time or date but is im-
portant to that role. The unsched-
uled event will appear only on your 
Weekly Compass. To change or 
remove a role, select the role and 
click Edit or Delete.

Use the Show schedule for date field to display your sched-
uled tasks and appointments for a specific day. This allows 
you to quickly view a specific day before scheduling a Master 
Task List item or an item corresponding to your Weekly Com-
pass. Toggle between your tasks and appointments by click-
ing the Show Tasks or Show Appointments radio buttons.
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The Daily Planning Tool

The heart of the Franklin Covey methodology is Daily Planning. At 
the beginning of each day or at the end of the previous day, it is 
important to give yourself an strategy of how you intend to spend 
your day. Of course, these plans can change, but without a daily 
strategy, you could easily spend the entire day dealing with 
“urgent” or unimportant matters without accomplishing what 
really matters most to you.

Using the Daily Planning Tool
1. Open the Daily Planning Tool. The icon is found on the 

What Matters Most toolbar. The Daily Planning 
introduction screen appears.

There are four steps in the Daily Planning process: Review 
Yesterday, List Today’s Events Realistically, Assign Value to 
Your Tasks, and Assign Order to Your Tasks.

2. Click the Next button until you reach the Review 
Yesterday screen. This is important because helps you 
gauge how you spent the previous day. You may find that 
you planned appropriately, or that you may need to plan 
differently. 

From the Show drop-down 
menu, you can choose to view 
All Tasks, Complete Tasks, 
Deleted Tasks, Forwarded 
Tasks, and Incomplete Tasks. 
These categories are based on 
the action codes you assigned 
to the tasks during the week.

Select the day you want to 
evaluate.

As you review, you may find that the status of one or more of your tasks has changed and 
requires a different action code. To change the action code, select the task, click Assign 
Action, and choose the proper code from the drop-down menu that appears.
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3. Click Next. The List Today’s Events Realistically screen 
appears. As you think about your day, you probably 
already have a few items to add to you Prioritized Daily 
Task List or Appointment Schedule. Remember, be 
realistic about your time. 

4. Click Next. The Assign Priority to Your Tasks screen 
appears. The next step is to Prioritize your daily tasks 
using the A,B,C priority codes. See page 47 for further 
explanation of the codes.

To add a task or appointment, 
click the Add... button and select 
Task or Appointment from the 
drop-down menu. The corre-
sponding Properties dialog box 
appears. To edit a current task 
or appointment in your list, se-
lect the event, choose Edit, and 
choose Task or Appointment. 
You can also double-click the 
task or appointment you want to 
edit.

This section displays all the tasks 
on the current day’s Prioritized 
Daily Task List, including any you 
may have just forwarded from the 
Review Yesterday screen.

The Appointments list displays the appointments sched-
uled for today. As you schedule new appointments, 
make sure you plan realistically and don’t overload your 
schedule.

Select a task from the list, and then choose A Priority, B Priority, or C Priority.

This section displays the tasks 
you just reviewed and created in 
the previous screens. The list will 
also display tasks that you for-
warded to this day. These tasks 
may already have priority codes. 
You can keep those codes, or as-
sign new codes.
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5. Click Next. The Assign Order to Your Tasks screen 
appears. The final step is to rank your tasks within their 
priority codes. This should help you determine which of 
your tasks is the most important and focus you on that 
task.

For more information ...
There are several resources that provide you with additional help 
and information concerning the Weekly and Daily Planning 
Tools. The supplemental book provided with this software 
provides a detailed look at the different stages in the What Matters 
Most process. There are also multimedia pieces included on your 
installation CD that visually paint a picture of the process. Finally, 
the online Help included with the software has detailed help on the 
Weekly and Daily Planning Tools. You can access the online Help 
by clicking the Help button in each of the screens or by hitting F1 
at any time.

Your tasks are listed in random order. To change the order of your tasks, select a task and choose 
Move Up or Move Down to place the task in the desired location. The tasks will be automatically 
renumbered. Continue this process until you have ordered all your tasks just the way you want 
them.

You can choose to view all your 
tasks, or view them according to 
their priority codes. Select All 
Task Properties, A Priority 
Tasks, B Priority Tasks, or C 
Priority Tasks.
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Chapter 6

Organize Your Appointments
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Appointment Schedule Basics

The Appointment Schedule is a powerful and easy-to-use 
organizing tool that helps you manage your time efficiently.

Besides just scheduling appointments, the Franklin Planner 
Software Appointment Schedule lets you attach notes, files, and 
contacts to appointments; set reminder alarms; and create repeat 
appointments.

The Appointment Schedule allows you to:

■ Create regular appointments and repeat appointments

■ Attach notes, objects, and files to appointments

■ View your appointments by day, week, month, or year

■ Set early warning alarms for appointments

■ Add events such as birthdays, anniversaries, holidays, and 
vacations to your Appointment Schedule with the Special 
Days feature

The Appointment Schedule Main View

Appointment Schedule toolbar 
(see page 69).

Date Navigation Bar (see page 37).

Special Days are displayed at the 
top of each day (see page 73).

Diplays appointments (customize 
view and colors in Appointment 
Preferences).

Add or edit appointment notes 
(displays any notes entered in the 
Notes tab of the Appointment 
Properties dialog box).
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The Appointment Schedule Toolbar

Add a new appointment

Edit an appointment

Delete an appointment

Add a Special Day

Create a Repeat Appointment

Move Current Day left

Daily view

Weekly view

Monthly view

Yearly view

Spell check

Date/Time stamp

Link a contact to an appointment

Attach a file to an appointment
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Working with the Appointment Schedule

Creating a new Appointment
1. Open the Appointment Schedule.

2. Click the New Appointment button.

or 

Select New Appointment from the Edit menu. 

3. If you click the New Appointment button or select New 
Appointment from the Edit menu, the Appointment 
Properties dialog box will appear. 

4. There are three tabs in the Appointment Properties dialog 
box: Properties, Notes, and Repeat. 

5. Click on the Properties tab. Enter your appointment 
information. 

To set an alarm for the appoint-
ment, check the Turn on alarm box. 
In the Minutes box, enter the num-
ber of minutes before the appoint-
ment that you would like this alarm 
to ring.

Enter a description of the appoint-
ment. The description can have a 
maximum of 255 characters.

Enter the date for the appointment. 
The default date is today’s date.

Choose a category from the Cate-
gory drop-down menu. See page 40 
for information about creating cate-
gories.

Indicate the starting time by enter-
ing a time in the Start Time field or 
by dragging the dark blue bar on the 
timeline to the starting time.

Indicate an ending time for the 
appointment by entering a length 
of time in the Duration field or by 
dragging the dark gray bar in the 
timeline to the ending time.

Link contacts to the appointment. 
You can choose to show contact 
information in the Notes field in 
the main view.

Attach files, images, 
or objects to a spe-
cific appointment.
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6. Click the Notes tab. Enter any notes you want to attach to 
the appointment. These will be displayed in the Notes field 
in the Appointment Schedule main view.

7. Click the Repeat tab. Enter information if you want to 
make this appointment repeat on a regular basis.

If you select the 1st, 5th, or Last boxes in the Weeks field , 
make sure the day you have selected occurs in that week. For 
example, if you select the Thursday and Last boxes, there must be 
a Thursday in the last week of the month or the appointment will 
not appear.

8. Click Finish. The appointment will appear on your 
Appointment Schedule.

How to set up some common repeat appointments:

■ Project meeting on the 3rd of every month.

Enter a “3” in the Day field and a “0” in the Month field. The 
appointment will appear on the 3rd of each month.

Click here to enable the repeat 
feature for the appointment.

Enter the dates you would like to have 
the appointment begin and end appear-
ing on your Appointment Schedule.

Enter a specific date or day of the 
month for an appointment to repeat. 
Enter a “0” in the Month field to re-
peat an appointment on the same 
day every month. 

This control reads like a sentence. 
“This appointment will repeat once 
every ______.” For instance, enter a 
“2” in the Every field and click the 
Weeks button. The appointment will 
repeat once every two weeks start-
ing on the date in the Starting Date 
field.

This control allows you to specify 
the days of the week on which the 
appointment will appear. By de-
fault, every day is checked. 

This control is used with the Weekdays field to further 
define the repeat appointment. After you have selected 
from the Weekday(s) field, you can then decide which 
weeks of the month you want to view the appointment.
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■ Golf every Wednesday morning.

In the Weekdays field, check just the Wednesday box. Then 
check all the boxes in the Weeks field. The appointment will 
appear every Wednesday.

■ Lunch meeting once every two weeks.

Enter a “2” in the Every field and click the Weeks button. Set 
the Starting Date to the day you want the task to begin to 
appear (if not the current day).

Editing an Appointment
Appointments are often dependent on other people’s schedules. 
Consequently, your appointment schedule can change often 
during the day. You can make changes to any appointment 
description, start time, notes, or attachments.

1. Select an appointment.

2. Select Appointment Properties from the Edit menu or 
click the Edit Appointment button. The Appointment 
Properties dialog box appears.

3. Make changes to the date, duration, category, or 
description of the appointment. You can also change the 
alarm settings as well as add or delete any attachments to 
the Appointment. (If you change the date field, the 
appointment will no longer appear on the appointment 
schedule of the original day)

4. Under the Notes tab you can add or edit your 
appointment notes.

5. After you have finished making your changes, click OK.

Creating a New Repeat Appointment
Another way to create a repeat appointment is to use the Repeat 
Appointment dialog box. The controls remain the same as the 
Repeat tab described on page 6-5, but you are not able to disable 
the repeat feature (you must simply delete the appointment if you 
no longer want it to repeat.) 

1. Open the Appointment Schedule

2. Click the Repeat Appointment button.
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or

Select Repeat Appointments from the Options menu.

The Repeat Appointment dialog box appears.

3. Click the Add button. The Add/Edit Repeat Appointment 
window appears. 

4. Set up the guidelines for your repeat appointment. See 
page 51 for details on the controls.

5. When finished, click OK. Then click Close to exit the 
Repeat Appointments dialog box.

Creating a Special Day
While daily tasks, appointments, and notes take up most of your 
day, don’t forget those special events that happen in your life. The 
Franklin Planner Software Special Days dialog box helps you 
remember events such as anniversaries, birthdays, holidays, and 
even business trips. Once a special day is entered in the Special 
Days dialog box, the Franklin Planner Software does all the work 
of reminding you of these days.

1. Click on the Special Days button.

or

Select Special Days from the File menu.

2. The Special Days dialog box appears.

3. Click New. The Special Day Detail dialog box appears.
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Each time you launch the Franklin Planner you can be alerted 
if the current day is a Special Day.  Go to Application 
Preferences to show Special Days at Startup. See page 38 for 
more information.

4. Click OK. Your Special Day will appear at the top of the 
day in the Appointment Schedule main view.

Adding an Alarm to an Appointment
1. Select an appointment.

2. Select Appointment Properties from the Edit menu or 
right click on the appointment and select Appointment 
Properties from the drop down menu. The Appointment 
Properties dialog box appears.

3. In the Alarm Properties field, check the Turn on alarm 
box.

4. In the Minutes box, enter the number of minutes before 
the appointment that you would like this alarm to ring. 

Enter the number of days 
before the event that you 
would like to be reminded. 
The Appointment Schedule 
will give you a countdown to 
the special day.

This control reads like a sen-
tence. “This Special Day will 
repeat once every ______.” 
For instance, enter a “2” in 
the Every field and click the 
Weeks button. The Special 
Day will repeat once every 
two weeks starting on the 
date in the Starting Date 
field.

If the event occurs on one 
specific day (such as a birth-
day) complete the Month and 
Day fields. 

This control allows you to specify the days 
of the week on which the Special Day will 
appear. 

Enter a description of the 
Special Day.

Select a Special Day category 
from the drop-down menu.

If the event is more 
than one day in length 
(such as a vacation) 
enter the beginning 
and ending dates of 
the event in the Start-
ing Date and Ending 
Date fields. 

This control is used 
with the Weekdays 
field to further define 
the Special Day. After 
you have selected 
from the Weekday(s) 
field, you can then de-
cide which weeks of 
the month you want to 
view the Special Day.
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If no early warning time is entered (0),  the alarm will sound at 
the start time of the appointment.

5. Click OK. When an alarm has been set for an 
appointment, the Alarm button appears as a ringing bell 
in the upper right corner of the appointment block.

The alarm will use the system default sound to “ring.”  To set 
or change this sound, choose Start, Settings, Control Panel, 
Sounds and adjust the Default Sound.

Printing Your Appointment Schedule
1. Open the Prioritized Daily Task List.

2. Select Print Tasks, Appointments and Notes from the File 
menu. The Print Tasks, Appointments and Notes window 
appears. Adjust the settings as needed.

3. Click the Options button to view more printing options. 
See below for descriptions of each feature.

Use this control to set the 
margins of your printing ar-
ea. Unless you are familiar 
with this feature, leave the 
values at 0.000. If the print-
out is not aligned, print a 
test page, then adjust the 
values as needed and print 
another test page until the 
page aligns properly.

Select your binder page 
size from the drop-down 
menu. You can also print 
to plain 81/2 x 11 paper. 

View the page(s) you are going 
to print so you can verify that 
what you want to print is what 
will actually print.

Choose which pages of 
the daily view to print. 
This emulates the layout 
of regular planner pag-
es, so the left pages in-
clude your task list and 
appointments. The right 
pages include your Daily 
Record of Events and 
Task/Appointment 
notes. 

Select the starting 
and ending dates of 
the information you 
want to print. Select 
the same date for 
each field to print 
just one day.

Make adjustments to 
the printer setup, 
such as the printer 
selection, paper size, 
or paper source. 
Make any adjust-
ments, then click OK.

More printing options 
are available. See the 
next page for more de-
tails.
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4. After you set all of the controls, click Print.

For more information ...
The online Help system included with your Franklin Planner 
Software provides documentation on all of the other features of 
the Appointment Schedule including:

■ Attaching files and graphics to appointments

■ Linking contact information to appointments

■ Setting Appointment Schedule preferences

■ Switching between Daily, Weekly, Monthly, and Yearly 
views

■ Printing weekly, Monthly, or Yearly calendars

To access the online Help, select Contents and Index from the 
Help menu, or press F1 at any point.

Select the filler style (Sea-
sons, Original, etc.) to 
which you want to print. 
This will vary by the binder 
size chosen above. 

This control allows you to 
check which items to include 
in the printing. Check a box 
to include the item, or un-
check it to exclude it from 
this printing.

This displays your destina-
tion printer. If this is incor-
rect, click Setup and change 
you printer settings. 

Use the Filter drop-down menu to 
choose and apply one of your Priori-
tized Daily Task List Filters before 
you print to limit your data.

To print in color (i.e. 
category colors) check 
the Print in Color box. 

The Edit Appointment Range button allows you to customize how 
your appointments are printed on plain paper. (This option is not avail-
able if you are printing to a Franklin Covey filler.) Click the Edit Ap-
pointment Range button. The Edit Appointment Range dialog box 
appears. If you check Print Appointments Sequentially, your appoint-
ments will be printed without showing time in the day that is unsched-
uled. If you select 15 or 30 minute increments, the entire day will be 
printed using the increment you select. Use the Range Time drop-
down menu to select a range of time that will print. Click OK. 
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Address and Phone Book Basics

The Franklin Planner Software Address and Phone book is a 
powerful personal contact management tool that allows you to 
keep track of addresses, phone numbers, and notes for business 
contacts, relatives, and friends. 

Using the Address and Phone book, you can:

■ Keep categorized lists of addresses and phone numbers.

■ Create custom categories and filters.

■ E-mail a contact directly from your contact list (using 
your e-mail application). 

■ Dial (using a modem) any selected number from the 
Address and Phone book. The Franklin Planner Software 
Speed Dial function is Microsoft TAPI compliant.

■ Print mailing labels and envelopes.

■ Print a hard copy of your phone and address book.

The Address and Phone Book Main View

Search for a 
contact.

Click header to 
display list by last 
name, first name, 
or company.

Double-click to view 
and edit contact in-
formation.

Displays contact’s phone 
numbers. Numbers can 
be edited from this view.

Displays address information. 
Information can be edited 
from this view.

Displays any notes you have 
entered. Note information 
can be edited from this view.

Address and 
Phone toolbar.

Displays default e-mail for contact. Click the e-mail button 
to launch your e-mail application.
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The Address and Phone Book Toolbar

Speed Dial

Add contact log

Date/Time Stamp

New entry

Edit entry

Delete entry

Create a filter
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Working with Address and Phone Book

Creating a new Address and Phone entry
1. Click the Address and Phone icon to open the Address and 

Phone book. 

2. Click the New Entry button. The New Phone Entry dialog 
box appears.

3. There are five tabs in the New Phone Entry dialog box to 
help you create a complete Address and Phone record: 
Personal, Address, Notes, Important Dates, and Contact 
History.

4. Begin creating your Address and Phone entry in the 
Personal window. Enter your contact’s name, spouse’s 
name, company, assistant’s name, title, department, and 
other information. The Personal tab is described on the 
next page.

A Hailing is useful for printing labels or envelopes if you want 
to use something other than the contact’s First and Last 
name, such as including a spouse’s name on invitations.

Select a category from the drop-
down list. For more information 
on categories see page 40.

Check the VIP box if you consider 
this a very important record. You 
can then create a filter to display 
just the phone records that you 
have marked as VIP’s.

Check the box to add this 
record to your Speed Dial 
window.

From the drop-down 
menu, choose to list 
the contact by Name, 
Company, or Name & 
Company.

If you are using a Palm device, 
the private setting hides the entry 
from view on the Palm device. 
Check the box to mark an entry 
as private. 

Select a description from the 
Description field. If you want to 
add or delete available phone 
number descriptions choose 
Options menu, Edit Phone 
Number Types. 
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5. Next, select the Address tab. Record the street addresses 
and e-mail addresses of your contact.

6. Click the Notes tab. Enter any additional notes that 
provide extra information about the contact.

7. Click the Important Dates tab. This tracks any significant 
dates such as birthdays, anniversaries, etc. for your 
contact.

Enter the address(es) of your contact.Select a description from the 
drop-down list, or type in your 
desired description. You can 
choose any of the following 
predefined descriptions: 
Home, Mailing, Shipping, or 
Work.

Enter an e-mail address into 
any of the fields, then select the 
radio button to the right of the 
field to designate the address 
that will be displayed as the de-
fault e-mail address. The default 
e-mail address will appear in the 
e-mail field of the main Address 
and Phone window when a con-
tact is selected (see page 7-2).

If you maintain a large contact list, adding key codes to an 
entry will give you additional options when creating a filter or 
performing a Global Search. (i.e. - Enter “tennis” as a key-
word for all your tennis partners, then create a filter that dis-
plays only the keyword “tennis” for a quick list.)

Enter a description of the important 
date, such as “Matt’s Birthday” or 
“My anniversary.”

Enter the Date of the occasion.

Complete the Gender field to assist 
you in purchasing a gift or selecting 
a card for an individual.

Select a category from the drop-
down list. Go to the Options menu 
and select Important Date catego-
ries to create new categories.
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8. Finally, select the Contact History tab. With the Contact 
History dialog box, you can track phone calls, tasks and 
appointments for all your important business and 
personal contacts. You can only access the Contact 
History tab after a contact has been saved.

9. After entering your data, click either the Save button or 
Save and Close button to save your information. Clicking 
Save will leave the dialog box open for you to add more 
information.

Editing an Address and Phone entry
1. Select the entry that you would like to edit in the Address 

and Phone book.

2. Click the Edit button. You can double-click on the entry 
to open the entry. The entry window opens with all the 
Address and Phone information for this record.

3. Make changes to the appropriate fields and click the Save 
button or Save and Close button

Creating a Mail Merge with your contact data
Your Franklin Planner Software lets you merge names and 
addresses from your Address and Phone book to your favorite 
word processor. The Mail Merge supports Microsoft Word 95 and 
97, as well as WordPerfect 6.1, 7, and 8. Mail Merge gives you a fast 

Click Add and select one of the fol-
lowing options: Add a New Task, 
Add a New Appointment, Add a New 
Contact Log, Add a New Object, Add 
a New File Attachment, or Add a 
New Image Attachment. The appro-
priate dialog box will appear. Press 
F1 to access the online Help for 
more information.

As you begin to build a large contact 
history, you may find it helpful to be-
gin limiting how far back you view 
the contacts. The software is preset 
to view the past year of contacts.

This area will display the date and the description of every 
item you add.
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and easy way to use your Address and Phone book to generate 
personalized letters.

When you choose Mail Merge, only those names and addresses 
that match the conditions of the current filter are exported and 
merged. 

To use the Mail Merge feature, you will need to create  one or 
more merge files that can be used to import your Address and 
Phone information. You can create these files by modifying either 
AXFORM.DOC (for Word users) or AXFORM.FRM (for 
WordPerfect users) to create your own personalized letters.

1. Open the Address and Phone book.

2. Choose Mail Merge File from the Options menu.

3. The Mail Merge dialog box appears. Choose the word 
processor you wish to use (this word processor must be 
already installed on your computer), then choose the 
Merge Document you wish to use. To do this, click the 
Browse button, which brings up the Open Mail Merge 
Document window. Navigate through your folders until 
you find the merge document you want to use (a 
document with a .DOC extension if you are using 
Microsoft Word, or a .FRM extension if you are using 
WordPerfect). When you have selected the document, 
click Open to get back to the Mail Merge window.

4. Next, in the Merge To box, choose whether you wish to 
merge to a Document or to the Printer. If you merge to a 
Document, your names and addresses will be inserted into 
the letter format of your merge document, where you will 
be able to make changes to the letter before printing. If 
you merge to the Printer, the merged document will go 
straight to the printer without giving you a chance to edit 
it. 

5. To finish the merge, click Merge. Your desired word 
processor is started, and the names and addresses from 
your Address and Phone book are inserted into the name 
and address block of the merge document.

If you’re adept at using merge files  with your word processor, 
you an also export Address and Phone information to an ASCII 
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text file for import into your word processor, where you can do 
much more than simply create letters.

Printing your Address and Phone book
1. Open the Address and Phone book.

2. Select Print Address and Phone from the File menu. The 
Print Address and Phone dialog box appears.

3. The top half of the print dialog is fairly consistent for all 
the Franklin Planner Software modules. 

4. Click the Options button to view more printing options. 
The Address and Phone print options are contained in 
three tabs: Report Format, Selection, and Contacts to 
include .

5. Click the Report Format tab.

View the page(s) you are go-
ing to print so you can verify 
that what you want to print is 
what will actually print.

Select your binder page size 
from the drop-down menu. 
You can also print to plain
81/2 x 11 paper. 

Use this control to set the 
margins of your printing area. 
Unless you are familiar with 
this feature, leave the values 
at 0.000. If the printout is not 
aligned, print a test page, 
then adjust the values as 
needed and print another test 
page until the page aligns 
properly.

Choose which pages of the 
daily view to print. This em-
ulates the layout of regular 
planner pages, so the left 
pages include your task list 
and appointments. The right 
pages include your Daily 
Record of Events and Task/
Appointment notes. 

If you are printing infor-
mation from the Con-
tact History tab, select 
the starting and ending 
dates of the information 
you want to print.

Make adjustments to the 
printer setup, such as 
the printer selection, pa-
per size, or paper 
source. Make any ad-
justments, then click OK.

More printing 
options are 
available. See 
below for de-
tails.
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6. Pick the style of report you want to generate form the Style 
drop-down menu.

■ Address and Phone Detail will list most of the 
information from the Personal, Address, and notes 
tab of the contact’s entry.

■ Phone Index will print phone numbers and e-mail 
addresses.

■ Contact History will print information contained in 
the Contact History tab of the contact’s entry 
(including tasks and appointments created through 
contacts).

7. The Print drop down menu further defines the extent of 
the information printed. 

■ Company will print just the company fields from your 
data.

■ Name will print just the name fields from your data.

For instance, if you are printing the “B” section of your data, 
selecting “Company” will print all company starting with “B.” 
Selecting “Name” will print all names starting with “B.”

8. The By Name and By Co. fields give you options on how 
each of those fields is ordered. 

■ If you selected Name from the Print drop-down 
menu, the By Name field will give you options for how 
the name information will be printed.

■ If you selected Company from the Print drop-down 
menu, the By Co. will give you options for how the 
company information will be printed.
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9. Checking Page Break After Each Letter will begin each 
letter of the alphabet at the top of a new page.

10. Click the Selection tab.

11. From the Sort by drop-down menu, select the field by 
which you want your contacts listed. 

■ Name/Company will display your records 
alphabetically by Name and Company information

■ Postal Code will group the records by the postal code.

■ State will group the records by state.

12. The Order field allows you to decide whether you want the 
records to be printed in Ascending order (Z-A) or 
Descending order (A-Z).

13. The Address field determines which address(es) from the 
records you want to include in the printing. These are 
defined by the categories you assign in the Address 
window of the contact’s entry.

14. The Print From fields determines what range of records 
you have printed. Records filed by a numeric value “#” are 
before the letter “A.” So the order is “#”-“A”-“B” etc.
86 Franklin Planner Software Manage Your Contacts



FPS Windows 7.2 Manual.book  Page 87  Tuesday, February 29, 2000  2:05 PM
15. Click the Contacts to include tab.

You have four choices of contacts to include:

■ Selected contact – If you select Print Address and 
Phone while viewing a contact, you can print the one 
contact by checking this box.

■ Contacts based upon a category – You can choose to 
limit your list by choosing a category. Only records 
that have been assigned that specific category will be 
printed. 

■ Contacts based upon a filter – You can choose to limit 
your list by choosing a filter. Only records that match 
the filter description will be printed. 

■ All Contacts – All your records will be included.

16. Click Print to print your Address and Phone list.

For more information ...
The online Help included with your Franklin Planner Software 
provides documentation on all of the other features of the Address 
and Phone book including:

■ Setting preferences

■ Printing labels and envelopes

■ Establishing filters

■ Quick Call Log

■ Linking files, objects, or images in the Contact History tab

■ Creating tasks and appointments from the Contact 
History tab

To access the online Help, select Contents and Index from the 
Help menu, or press F1 at any point.
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Basics of the Daily Record of Events

In the Daily Record of Events module, you can record the details 
of daily commitments, transactions, and conversations. For 
example, if you receive an unexpected call from a business 
associate who asks you to give a presentation on Monday, use the 
Daily Record of Events page to take down the details of the 
discussion. You can later create an appointment on Monday’s 
Appointment Schedule and use the information you entered on 
the Daily Record of Events to create tasks to help you prepare for 
the presentation.

In the Daily Record of Events you can:

■ Record details of your meetings, conversations, and 
transactions

■ Format your text entries

■ Insert names and phone numbers from the Address and 
Phone book

The Daily Record of Events Main View

Daily Record of Events toolbar

Date Navigation bar 
(see page 37)

Enter and format text so 
that you can easily find 
information.

Include files, images, 
or objects
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The Daily Record of Events Toolbar

Cut selected text

Copy text to clipboard

Paste text from clipboard

Bold text

Italicize text

Underline text

Change font style

Align text left

Center text

Align text right

Insert bullets

Date/time stamp

DRE Index

Spell check
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Using the Daily Record of Events

Adding a Daily Record of Events entry
1. Click the Daily Record of Events button on the main 

toolbar. The Daily Record of Events window appears. 

2. Enter your data in the text window.

3. Format your data using the Daily Record of Events 
toolbar.

4. Your data is automatically saved. 

Use the Date and Time stamp to track multiple entries on a single 
day.

Creating a Daily Record of Events Index
The Daily Record of Events Index is helpful because it allows you 
to track your notes by title or by the date on which the notes were 
entered.

In the Daily Record of Events Index dialog box, you can:

■ Give titles to your Daily Record of Events entries

■ View Daily Record of Events within a specific date range

■ Sort Daily Record of Events titles by name or date

Adding Entry Titles to the Index
1. With the Daily Record of Events module active, click the 

Index button or select Index Entries from the Options 
menu. The Daily Record of Events Index dialog box 
appears.

2. Click Add Index. The Index Properties dialog box appears.

3. Enter an Index Description. This is the title that appears in 
the Daily Record of Events Index.

The description you 
enter an is the title 
that appears in the 
Daily Record of 
Events Index.
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4. Click OK. The Daily Record of Events entry title appears 
in the Daily Record of Events Index dialog box.

When you create an Index description , you are giving a brief 
description of an event recorded on the day’s Daily Record of 
Events. You can give multiple descriptions to one day, but you 
cannot edit information under each description. If you have 
multiple descriptions for one day, the information contained in 
each description will be identical.

Editing and Deleting Index entries
1. Click the Daily Record of Events Index button or select 

Index Entries from the Options menu. The Daily Record 
of Events dialog box appears.

2. To edit an entry description, select an entry and click Edit 
Index. The Index Properties dialog box appears.

3. Make changes to the description or the date and click OK.

4. To delete an entry description, select an entry and click 
Delete Index. A warning appears, asking if you really want 
to delete this index. Click Yes. The entry is deleted.

Managing your Index entries
The Daily Record of Events Index dialog box gives you several 
options for displaying your index entries.
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Printing Your Daily Record of Events
1. Open the Daily Record of Events.

2. Select Print Daily Record of Events from the File menu. 
The Print Daily Record of Events window appears.

3. Make changes to the print setup as needed.

The Display Options field allows 
you to select which entries will 
be displayed by limiting the be-
ginning and ending dates. Ad-
just the List index entries from 
field to set the beginning date. 
Adjust the List Index entries to 
field to set the ending date. Only 
index entries that fall between 
the beginning and ending dates 
will be displayed.

By checking the Special Entry box, you can 
designate an entry or entries as having special 
significance. The box will appear checked when 
you select a Special Entry.

You can sort your entries chronologically by 
date or alphabetically by name by selecting 
the appropriate radio buttons in the Sort By 
field.

Select your binder page size from 
the drop-down menu. You can also 
print to plain 81/2 x 11 paper. 

Use this control to set the 
margins of your printing ar-
ea. Unless you are familiar 
with this feature, use the pre-
set values If the printout is 
not aligned, print a test page, 
then adjust the values as 
needed and print another 
test page until the page 
aligns properly.

Select the starting and 
ending dates of the infor-
mation you want to print. 
Select the same date for 
each field to print just 
one day.

View the page(s) you are go-
ing to print so you can verify 
that what you want to print is 
what will actually print.

Make adjustments to the 
printer setup, such as the 
printer selection, paper 
size, or paper source. 
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4. When finished, click Print.

Printing your Daily Record of Events Index
1. Open the Daily Record of Events.

2. Select Print Daily Record of Events Index from the File 
menu. The Print DRE Index window appears.

3. The Print DRE Index dialog box uses the same controls as 
the Print Daily Record of Events described above. 
However, it does have an additional control.

4. Click Options. The window expands.

5. When ready, click Print.

For more information ...
To access the online Help, select Contents and Index from the 
Help menu, or press F1 at any time.

Select to sort by either 
date or name. This will 
sort the entries that fall 
within the date range al-
phabetically by name or 
chronologically by date.
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Basics of the Information Manager

The Information Manager contains five modules: What Matters 
Most information, Turbo Files, Journal, Quotes, and Notes. These 
areas are useful for storing information that will help you organize 
your day more efficiently. 

■ The What Matters Most module is a place to review, add, 
or make changes to your Governing Values, Roles, 
Mission Statement, or Long-Range Goals. Also, if you do 
not want to use the What Matters Most Wizards to 
identify your Values, Roles, Mission, or Long-Range 
Goals, you can use the forms provided in the Information 
Manager to do the same things. 

■ The Turbo Files module is a fast, computerized index that 
allows you to track of miscellaneous information such as 
the date and title of an interesting magazine article, or the 
location of an important piece of mail.

■ The Journal module is a place for you to record daily 
thoughts or notes.

■ The Quotes module allows you to store and categorize 
your favorite quotes. You can attach key words to each 
quote, making it easier to locate quotes on an idea or topic 
you might have. 

■ The Notes module is helpful for storing miscellaneous 
information such as gift lists, idea lists, or any other 
information that may not be specifically linked to one 
appointment or task.

Many of the modules allow you to format text using the same text 
editor available in the Daily Record of Events. See “The Daily 
Record of Events Toolbar” on page 91 for an explanation of these 
controls.

In the Information Manager preferences you can select the 
modules you want to be displayed. See “Setting Preferences” on 
page 38 for more information.
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The Information Manager Main View

Change the way items in the right pane are displayed.
Delete an item.

Add a new item.

Edit an item.

Click node to expand topic.

Expanded nodes reveal 
more detailed infomation 
about the contents. Selected information will be displayed in the right pane.
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What Matters Most

Discovering What Matters Most to you will probably be a 
continual process. However, once you have established a set of 
governing values, a list of roles, and a mission statement, you may 
only need to make minor changes from time to time. The What 
Matters Most module of the Information Manager allows you to 
build your governing values, roles, mission, and long-range goals, 
but it does not offer the prompts and specific guidance included in 
the What Matters Most Wizards. For information on using the 
What Matter Most Wizards, see chapter 2 of this manual. The 
Information Manager and the What Matters Most Wizards access 
the same data, so additions or changes you make in one module 
will be reflected in the other.

Working with Governing Values

Creating a New Governing Value

1. Open the Information Manager, expand the What 
Matters Most node, and select the Governing Values 
topic. Click the New Governing Value button. The 
Governing Value dialog box appears.

2. Click Save to save your Governing Value. 

3. Click the close button to exit the window.

Enter a description of your 
Governing Value.

Enter a statement that 
clarifies your value.

The Linked Goals list will dis-
play any Long-Range Goals 
you have linked to this value.
If you are creating a new value, 
the list will be empty. 
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Editing a Governing Value

1. Select the Governing Value you want to edit and click the 
Edit Governing Value button.

2. The Governing Value dialog box will appear. Make your 
changes and click the Save button to save your changes.

3. To edit a Long-Range Goal, select the goal from the 
Linked Goals list and click the Edit Long-Range Goal 
button. The Long-Range Goal dialog box will appear. See 
page 9-7 for infomation on editing goals. 

4. Click the close button to exit the window.

Deleting a Governing Value

1. Select the value to delete and click the Delete button. The 
value will be removed form your list.

Working with Roles

Creating a new Role

1. Open the Information Manager, expand the What 
Matters Most node, and select the Roles topic. Click the 
New button. The Role dialog box appears.

2. In the Description field, enter a description of your Role.

Enter a description of 
your Role.

Enter the Key People that 
define the role. Click the 
New Key Person button.

Enter a Tribute Statement 
for each Key Person.

Displays any Long-Range 
Goals that you have linked 
to this role. Since you are 
creating a new role, the list 
will be empty.
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3. Click the New Key Person button. A “Key Person” will be 
highlighted in the Key People list for you to add a new Key 
Person. Enter the name of the Key Person.

4. Click in the Statement field and a cursor will appear. Enter 
a Tribute Statement for your new Key Person. 

5. To edit a Key Person, select the Key Person and click the 
Edit Key Person button. The Key Person will be 
highlighted for you to make changes. 

6. To delete a Key Person, select the Key Person and click the 
Delete Key Person button. The Key Person will be 
removed from your list.

7. Click the Save button to save your Role.

8. Click the close button to exit the dialog box.

Editing a Role

1. Select the Roles node, select the Role you want to edit, and 
click the Edit Role button.

2. The Role will appear. Make your changes and click the 
Save button.

3. If you have a Long-Range Goal linked to the role, it will be 
listed in the Linked Goals list. To edit the Goal, select the 
Goal and click the Edit Long-Range Goal button. The 
Long-Range Goal dialog box will appear. Make any 
changes and click the Save button.

4. Click the close button to close the dialog box.

Deleting a Role

1. Select the Roles topic, then select the role you want to 
delete. 

1. Click the Delete button. The role will be removed from 
your list.

Working with Mission Statements

Creating a New Mission Statement

1. Open the Information Manager, expand the What 
Matters Most node, and select the Mission Statement 
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topic. Click the New button. The Mission Statement 
dialog box appears.

2. Click Save to save your new Mission Statement.

3. Click the close button to exit the dialog box.

Editing a Mission Statement

1. Select the Mission Statement node, select the Mission 
Statement you want to edit, and click the Edit button. The 
Mission Statement dialog box appears.

2. Make any changes to the Mission Statement and click Save 
to save your changes.

3. To edit a Linked Goal, select the goal from the list and 
click the Edit Long-Range Goal button. The Long-Range 
Goal dialog box will appear. Make your changes and click 
Save.

4. Click the close to exit the dialog box.

Deleting a Mission Statement

1. Select the Mission Statement topic, then select the Mission 
Statement you want to delete.

2. Click the Delete button. The Mission Statement will be 
removed from your list.

Enter the title of the new 
Mission Statement.

Enter the text of the new 
Mission Statement.

Displays any Long-Range 
Goals that you have linked 
to this Mission Statement. 
Since the Mission State-
ment is new, the list will be 
empty.
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Working with Long Range Goals

Creating a Long Range Goal

1. Open the Information Manager, expand the What 
Matters Most node, and select the Long-Range Goals 
topic. Click the New Long-Range Goal button. The Long 
Range Goals dialog box appears.

When you view or edit  one of your Values, Roles, or Mission 
Statements, the Long-Range Goal(s) that you have linked to that 
item will be displayed.

2. Begin brainstorming about the events you will need to do 
to accomplish this Long-Range Goal. 

3. Once you have a list of intermediate steps, decide whether 
these steps will appear on your Prioritized Daily Task List, 
Master Task List, or Appointment Schedule.  If you wait 
until “someday” to do these items, most likely they will 
never get done. Scheduling the intermediate steps will 
help you accomplish these things you consider to be most 
important.

4. Enter your intermediate steps by clicking on the 
appropriate button:

Enter a description of the 
new Long-Range Goal.

Select a Governing Value, 
Role, or Mission Statement 
from the drop-down menu. 
Your new Long-Range Goal 
should be in line with what 
you have already identified 
as What Matters Most.

Enter intermediate steps. 
These become tasks and 
appointments.
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■ Add a Prioritized Daily Task. The Task Properties 
dialog box will appear for you to schedule a task to 
appear on you Prioritized Daily Task List. 

■ Add a Master Task. The Task Properties dialog box 
will appear for you to add the intermediate step to 
your Master Task List. 

■ Add an Appointment. The Appointment Properties 
dialog box will appear for you to schedule a specific 
appointment time. 

5. The Intermediate Steps list will display your events as you 
schedule each one. 

6. Click Save to save your new Long-Range Goal.

7. Click the close button to exit the dialog box.

Editing a Long Range Goal

1. Select the Long-Range Goals node, select the Long-Range 
Goal you want to edit, and click the Edit Long Range Goal 
button. The Long-Range Goal dialog box appears.

2. Make any changes to the Long-Range Goal and click Save 
to save your changes.

3. Click the close button to exit the dialog box.

Deleting a Long Range Goal

1. Select the Long-Range Goal topic, then select the Long-
Range Goal you want to delete.

2. Click the Delete button. The Long-Range Goal will be 
removed from your list. 
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Turbo Files

Turbo Files are a fast, computerized index that enable you to keep 
track of all your miscellaneous information, such as the date and 
title of an interesting magazine article, or the location of an 
important piece of mail. Think of Turbo Files as sophisticated card 
files that help you locate items in seconds.

Working with Turbo Files

Creating a New Turbo File

1. Open the Information Manager.

2. Select the Turbo File icon from the tree view. 

3. Click the New button. The Turbo File (new) dialog box 
appears.

4. When you have finished entering your information, click 
OK. Your Turbo File will be saved.

Editing a Turbo File

1. Select the Turbo File icon from the tree view.

Enter any keywords that 
will help you find items in 
the future.

Enter the physical location of the 
file or document. For example, 
drawer two, file three, or safety 
deposit box.

Enter the date the Turbo 
File was created or edited.

Specify the category of the 
item being indexed or filed.

Enter any additional information 
about the file item in the Notes 
field.

Enter the Turbo File Type. You can subcategorize items 
within each category by defining a Turbo File Type.

Enter the name of the article or title of the document you are filing.
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2. Either double-click on the entry you want to edit or click 
on the entry and click the Edit Turbo File button. 

3. Your Turbo File will open. If necessary, make changes to 
your information. Click OK when finished.

Deleting a Turbo File

1. Select the Turbo File you want to delete from the right 
pane.

2. Click the Delete button. The Turbo File will be removed. 
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The Journal

The Journal module is a place for you to record daily thoughts or 
notes.

Working with the Journal

Creating a New Journal Entry

1. Open the Information Manager and select the Journal 
node from the tree view.

2. Click the New Journal Entry button. The Select Journal 
Entry Date and Description dialog box appears.

3. Select the date to which you want to add a journal entry. 
Click OK. A Journal dialog box for that date appears. 

4. Enter your text and apply any of the text formatting tools 
to your entry.

5. Click Save. 

Editing a Journal Entry

1. Select the entry and click the Edit button.

2. Make any text or formatting changes.

3. Click Save.

Use the text editor 
controls to format 
your text.

Enter the text of 
your Journal entry.
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Adding Journal Index Entries

You can organize your Journal information for quick reference by 
using the Index feature to include a description of your journal 
entry.

1. Open the Journal node and select the Index topic. 

2. The Index Entries dialog box appears.

3. Click New Journal Index.

4. Enter a description and date for the entry. 

5. Click OK. Your journal entry will be filed under the date 
as well as the description that you entered.

6. When you are finished, click Close.

Deleting a Journal Entry

1. Select the Journal entry you want to delete from the right 
pane.

2. Click the Delete button. The Journal entry will be 
removed. 
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Quotes

The Quotes module allows you to store and categorize your 
favorite quotes. You can attach keywords to each quote, making it 
easier to locate a specific quote for an idea or topic. 

Working with Quotes

Creating a New Quote

1. Open the Information Manager.

2. Select the Quotes node from the tree view. Click the New 
Quote button.  The Quote dialog box appears.

3. Enter the quote information.

4. Click Save. Your quote will be saved.

Editing a Quote

1. Select the quote and click the Edit Quote button. 

2. Make any desired changes, then click the Save button.

Deleting a Quote

1. Click on the quote you want to delete.

2. Click the Delete button. The Quote is deleted.

If you desire, choose a Category 
from the drop-down menu.

Enter the author of the quote.

Enter up to five keywords associated 
with the quote. As you collect more 
quotes, you will find it helpful to 
search through your quotes using 
these keywords.

Enter the text of the quote.
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Notes

Whether it’s ideas for the meeting with the Creative Department 
next week, or keeping track of your son’s Little League schedule, 
you can organize it all with Notes. You can create as many Note 
files as you want. The Note Categories feature makes retrieval 
easier than any manual filing system. Note files are easy-to-use 
because you can create, edit and delete with the click of a button.

Working with Notes

Creating a Note

1. Open the Information Manager.

2. Select the Notes node from the tree view. Click the New 
Note button. The New Note dialog box appears.

3. Click Save. Click the close button to exit the dialog box.

Editing a Note

1. Select the Note and click the Edit Note button. 

2. Make the desired changes, then click the Save. 

Deleting a Note

1. Click on the Note you want to delete.

2. Click the Delete button. The Note is deleted.

Enter a description of the Note.

Format the text as desired.

If you desire, choose a category 
from the drop-down menu. See 
“Creating and Editing Categories” 
on page 40.

Enter the text of the Note.
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Printing from the Information Manager

All the modules in the Information Manager use a common print 
dialog box. The heading of the window will reflect the module you 
are printing from. 

1. Open the specific item (Note, Governing Value, Journal 
entry, etc.) you want to print.

2. Click the Print button. The appropriate print dialog box 
appears (i.e., when printing a Note, the Print Notes dialog 
box appears.)

3. After you set all of the controls, click Print. 

For more information ...
To get help in using any of the modules of the Information 
Manager, the online help documentation is always available. 
Simply hit the F1 key or click the Help button.

Select your binder page 
size from the drop-down 
menu. You can also print 
to plain 81/2 x 11 paper. 

Use this control to set the 
margins of your printing area. 
Unless you are familiar with 
this feature, use the preset 
values. If the printout is not 
aligned, print a test page, 
then adjust the values as 
needed and print another test 
page until the page aligns 
properly.

Choose whether you want every page, the left page(s), or the 
right page(s). The Left page and Right Page options allow you 
to print your entries double-sided. To do this, select Left 
page(s) first. After the printing is completed, select Right 
Page(s), load the pages that were just printed so that informa-
tion will print on the blank side, and complete the printing job.

Make adjustments to the printer set-
up, such as the printer selection, pa-
per size, or paper source. Make any 
adjustments, then click OK.

View the page(s) you are go-
ing to print so you can verify 
that what you want to print is 
what will actually print.
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Chapter 10

Maintaining Your Data
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The Basics of Maintenance Tools

The Tools and Utilities application is an independent program 
that allows you to keep your Franklin Planner database running 
smoothly.

With Tools & Utilities, you can do the following:

■ Back up your Franklin Planner database

■ Restore backup files

■ Purge or archive old data and compress active data

■ Repair your Franklin Planner database when necessary

Opening Tools and Utilities
1. Close Franklin Planner Software and Weekly Compass. 

2. Start Tools & Utilities by choosing Start, Programs, 
Franklin Covey, Franklin Planner, Tools & Utilities.

3. The User Login dialog box appears.  From the drop-down 
menu, select  the user name of the database you want to 
access.  Click OK.  The Tools & Utilities dialog box 
appears.
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Using the Maintenance Tools

Backing Up the Franklin Planner database
The Franklin Planner database contains the data that you’ve 
entered into the Franklin Planner program. You should back up 
your database regularly so that if the database file is ever lost or 
deleted, you won’t lose all the information and time you’ve 
invested. You can restore your backup file if catastrophe strikes.

It’s a good habit to make a backup file at least
once a week.

IMPORTANT

Always create a Franklin Planner backup file before making major 
database changes such as:

■ Importing data into your Address and Phone book

■ Exporting Address and Phone records

■ Rebuilding index data

■ Purging data from your Franklin Planner database

You can save a backup file on your computer’s hard drive, a 
network server, or a removable diskette. To copy a backup file to 
diskette, insert a formatted diskette into the disk drive. 

Franklin Planner software does not overwrite data on a diskette 
used for a backup, nor will it format the diskette. Diskettes used to 
store a backup file must already be formatted.

To back up your Franklin Planner database

1. Open Tools & Utilities by choosing Start, Programs, 
Franklin Covey, Franklin Planner, Tools & Utilities.

2. Click the Backup button on the Tools & Utilities menu.  
The Backup Database dialog box appears.

3. Click Browse. Specify a disk drive, folder, and file name 
for the backup file.  Click Save to return to the Backup 
Database window.

4. Select a compression type from the Compression Type 
drop-down menu: Minimum, Very Low, Low, Medium-
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Low, Medium, Standard, Medium-High, High, or 
Maximum.

Selecting Low is faster but may result in a larger backup file, 
whereas Maximum is slower but will result in a smaller file. 
Standard compression is sufficient for most purposes.

5. Click Backup to create a backup. If your data will not fit 
on one diskette, you will be prompted to insert additional 
diskettes.

6. When the backup is complete the following message 
appears: “The database backup was successful.” Click OK.

Your backup is now complete.

Restoring Your Franklin Planner database
If your Franklin Planner database is ever lost or deleted, use the 
Restore command to restore your most recent Franklin Planner 
backup file. You can also use the Restore command to load a 
backup Franklin Planner database from one computer to another.

1. If you saved your backup file on a diskette, insert it into 
the disk drive.

2. Click the Restore button.  The Restore dialog box appears.

3. Enter the name and location of the backup file you want 
to restore. (To locate the backup file, click Browse.)

4. Click Restore. When the Restore process is complete, the 
following message appears: “The database has been 
restored.”

5. Click OK.

Protecting your database with a password
Create a password so only you have access to your data. Once a 
password is set, the Franklin Planner Software cannot be opened 
without entering the correct password.

Creating a password

1. Click the Password button.  The Change Password dialog 
box appears.
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2. Enter a password in the New Password field. (The 
password  can be up to 14 characters and is not case 
sensitive.)

3. Retype the password in the Verify New Password field.

4. Click Change. The following message appears: “The 
password has been set.”

5. Click OK. Your Franklin Planner files are now secured by 
your password.

Changing a password

1. Click the Password button to open the Change Password 
dialog box.

2. Enter your old password in the Old Password field.  Enter 
a new password in the New Password field.  Enter it again 
in the Verify New Password field. 

3. Click Change. The following message appears: “The 
password has been changed.”

Removing a password

1. Click the Password button to open the Change Password 
dialog box. 

2. Enter your old password in the Old Password field.

3. Leave the New Password field blank and click Remove. 
The following message appears: “The password has been 
removed.”

Compacting the Franklin Planner database
As your Franklin Planner database grows, you may want to 
compress some of your Franklin Planner information to reduce 
the size of the database, which may allow the program to run 
faster.  If you have deleted old tasks, appointments or other 
records, compact your database to free this space on your hard 
drive.

1. Click the Compact Database button.  The Compact 
Database dialog box appears.

2. Click Yes to compact your database. The following 
message appears: “The database has been compacted.”
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3. Click OK.  Your database files are now compacted.

Purging and Archiving your database
When you purge data from the Franklin Planner Software, you 
cannot use the data in the software again. Purging the data 
permanently deletes the data you no longer need from your 
database.

If you make an archive, the data is saved as a text file and can be 
opened with a word processor or other text-editing program.   
However, archived records cannot be opened in the Franklin 
Planner program.

How often you archive or purge your data depends on your 
information storage and retrieval needs, your hard disk space, and 
how much you use the Franklin Planner software. Once a month 
is usually sufficient for most users. If you find that the program is 
getting sluggish, you may want to archive or purge old records to 
improve program speed. 

It is recommended that you back up your data before purging . 
If the purging is not successful, you will need to restore your data 
from a backup.

Purging Franklin Planner data

1. Click the Purge/Archive button.  The Purge/Archive 
dialog box appears.

2. Select the elements (Tasks, Appointments, and/or Daily 
Record of Events) you want to purge.

3. Enter the start and end date of the records you want to 
purge.

4. Click OK. The following message appears: “The database 
has been purged/archived.”

5. Click OK. You have finished the Purge process.

Archiving Franklin Planner data

1. Click the Purge/Archive button.  The Purge/Archive 
dialog box appears.
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2. Select the elements (Tasks, Appointments, and/or Daily 
Record of Events) you want to achieve.

3. Enter the start and end date of the information you want 
to archive.

4. Check the Archive box.

5. To specify where you want to save the archive file, enter a 
destination path and File Name, or click the Browse 
button to select a folder location. 

6. Click OK. The following message appears: “The database 
has been purged/archived.”

7. Click OK. The Archive process is complete.

Repairing the Franklin Planner Database
The Repair Database command synchronizes Franklin Planner 
database files with the index files. In other words, it cleans up any 
potential problems your index files may have developed.

1. Click the Repair button.  The Repair Database window 
appears.

2. Click Yes to repair the database. The following message 
appears: “The database has been repaired.”

3. Click OK. The Repair process is complete.
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